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Preface

This document is an instruction manual for XEI, an Image Processing Program for
SPM data developed by Park Systems. XEI, developed in Java, can be run on any
machine that supports Java Virtual Machine (JVM). This manual discusses in detail

the software features of the XEI program.

This manual explains the image analysis features in accordance with the standard
analyzing features useful for handling SPM data. This document describes, in detail,
every item that is displayed in XEI's user interface, and offers a wealth of information
regarding the use of a variety of analyzing tools and image processing modes to
produce enhanced images. It is quite important to make good use of the XEI image
processing program, just as it is important to collect the best possible data utilizing the
XEP data acquisition program. The XEI software will allow you to maximize the
system’s potential, however, by providing the ability to remove certain artifacts from
scan data and by allowing you to extract more information from the sample surface by

utilizing various analysis tools.

The contents of this manual are organized as follows. First, an overview of the main
categories in the XEl is provided so that you may browse for items of interest. Then,
the main processing and analyzing tools are more elaborately discussed in each
chapter. This software manual pays attention to all available modes and toolbars

and discusses their basic functions so that you can apply them to your data with ease.
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Chapter 1. Overview of XEI

Chapter 1. Overview of XEI

XEIl is an excellent software program that provides user-friendly and dynamic
tools for image processing, quantitative analysis and statistics, and export and printing
of processed images and measurement results. This chapter provides an overview
of the features and controls in the XEI program so that you can be more familiar with

its layout and capabilities.

1-1. Overall Features in XEI

To open the XEI program, double click the XEI icon @ on your computer’s

desktop. Figure 1-1-1 shows the XEI screen appearance that is displayed when

starting up the XEI program.

Title Bar Process Tools
: :
Maiiii Baies _’mm—ﬂﬂd
> G ts £ @
Analysis - -
Views

Navigator - -
Views

~ ) "
oo L ﬁ:ff

=

Figure 1-1-1. XEI - Image Processing Program
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1-1-1. Title Bar

The Title bar displays the title of the image processing program, XEI. Also, in
the preview screen, it indicates the Analysis view type (Information, Line, Region, 3D,
and Multi) you want to preview. For example, in Figure 1-1-2, the Title bar indicates

that the screen is displaying the preview of the Line view of the selected image.

Saastcs

Figure 1-1-2. Title bar in a preview screen
1-1-2. Menu Bar
The Menu bar includes several groups of menu items that are available for

working with SPM images. A more detailed explanation is provided in Chapter 2.

“Menus & Toolbar”.  Figure 1-1-3 shows menus, menu items and related icons.
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Figure 1-1-3. Menu bar
1-1-3. Toolbar

The Toolbar, shown in Figure 1-1-4, offers many icons for direct access to the
most frequently used basic functions. A more detailed description of the Toolbar is

also provided in Chapter 2. “Menus & Tool bar”

HEAS S [ e»> BN [@ B@tes R | &

Figure 1-1-4. Toolbar
1-1-4. Analysis View

The Analysis view is a worktable that allows you to work with the selected
image and to perform image processing and quantitative analysis on an image. As
shown in Figure 1-5-1, the Analysis view of the XEI has three parts: Analysis view tabs,
Image display panel and Analysis result & parameters display panel.

Above the Analysis view, there are seven tabs for opening the analysis view:
Information, Line, Region, Grain, PSD, 3D, and Multi. When you click each tab, the
Analysis view will be switched to the view you selected.

At the left side of the Analysis view, is the Image display panel that displays
an image with the palette panel and Histogram panel. You can display the image

that you want to process and analyze in the Image display. To bring an image file
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into the Image display panel, double-click the image from the Navigator view.

WARNING!

The contrast color in an image that was generated in the older version XEP
program (XEP 1.0) may be reversed. The darker color represents a higher height
and the brighter color represents a lower height value. Please, reset the contrast
settings so that the brighter color should be the higher height.

In the Image display panel, you can do the following things:

e Load animage from your hard disk into the Image display panel via the
Navigator view

e Adjust the color scale of an image with the palette panel

e Preview and print an image in the Image display panel

The right panel of the Analysis view varies according to the selected Analysis
view. That is, it displays an information table in the Information view; several data
plots in the Line or Region view; and 3D rendering parameters in the 3D view. Also,
in the Multi view, the Analysis view displays multiple images at one time. Figure 1-5-
1 shows the Analysis view of the Information view. Each Analysis view is described

further in each related chapter.

Information | Line | Region | Grain | PSD | 3D | Multi

um Channeliff Line Prafile: Red

=L Z
0179 um
S
\5

Line Profile: Green

0,093 pm

Line Profile: Blue

+2
+1.6
+1.2
+0.8
+0.4

+0

0.255 um

Statistics

Line Min(nm)  Max(um) Mid(um) Mean(um) Rpv(im) Ra(hm) Ra(m) Rz(nm)  Rsk(pm) Rku(pm)
M Red 178.986 2.189 1184 1.079 2010 753741 705060 210.325 -25705 583.893
Green 92926 2.309 1.201 1179 2216 537.062 468322 41.435 199422 954127
M Blue 254974 2265 1.260 1.077 2010 784263 731.421 366.939 160603 640313 b

Figure 1-1-5. Analysis View (in Line view)
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1-1-5. Navigator View

The Navigator view serves as a buffer for the images that you have already
opened in XEI. You can view basic information of each images in the navigator view
by placing mouse pointer over an image. (see the box in Figure 1-1-6)

To load a certain image from the ‘Navigator View’ to the ‘Analysis View’,
double click the image you want to load and then click ‘Yes’ to the warning message
saying that “This will initialize all the analysis views. Do you want to continue?”

Only one image can be loaded at a time. The loaded image is outlined in
blue color and check box beside its name is checked. Figure 1-6-1 shows the

Navigator view.

WARNING!

When the new image is loaded, the analysis results of the previously loaded
image (line profile, statistics table, histogram, etc.) in all the analysis views (Grain,
PSD, 3D...) and any changes made by imageprocessing will be removed as all the
analysis view is initialized. Therefore you should save all the necessary analysis
results and changes made to the image before you load new image to the analysis
view from the navigator view.

Navigator
|
B o a®
'ty
.0, 0"

256 (pxI) x 266 (pxI) . 5.66 (urn) x 5,66 (um) . X, Right to Left. Top to Bottom

o0 I
Channel tiff /] Cheese.tiff OVDAiff Fiber Aiff HardDisk tit Litho iff MouseSpermtiff
1

:
1 |
v v
Loaded image is Basic information of the image appears
outlined and checked when you place mouse over an image

Figure 1-1-6. Navigator view

There are three ways to bring images into the Navigator view:

o Drag and drop the selected images from your image directory into the
Navigator view (Figure 1-1-7).

e Select the ‘Open’ option in the File menu or click the ‘open data file’
icon to find an image you want to load (Figure 2-1-2).

e Use Send to XEl menu in the buffer window of the XEP.
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Figure 1-1-7. Drag and drop images into the Navigator view

When you right-click the cursor on an image in the Navigator view, a context
menu as shown in Figure 1-1-8 is generated allowing you to execute the following
actions: Load, Reopen, Delete, and Delete All.

{ . k Load o 5
Reapen
| Delete 8 5
3 ‘. Delete A ARSI

Figure 1-1-8. Context menu in the Navigator view

-

Mavigator
..

B Load

You can load the selected image into the Analysis view for image processing
and quantitative analysis.
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B Reopen

You can reopen the original image again in the Analysis view for a new
session or to refresh the image in order to perform image processing and analysis

again.

B Delete

Removes the selected images from the Navigator view.

B Delete All

Removes all images from the Navigator view.

1-2. Installation of Park Systems XEI’ Software

The XEI software program for XE systems can be run properly in:  Windows
XP Service Pack 2 or Windows 7(32bit) and Java SE Runtime Environment 6 or
higher. The Java Runtime Environment must be installed prior to installing ‘Park

Systems XEI’ software.

1-2-1. Uninstallation of the old version ‘Park Systems XEI’ program

1. Remove old ‘PSIA XEI or Park Systems XEI' program by using ‘Add or

Remove Program’ in the Control panel.
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# Add or Remove Programs Q@@

&L )

@ Currently installed programs: [ show updates Sort by: |Name v
&

Change or [a :
Rerove i i—,’} Park Systems SpringCal
Programs i& Park Systems Vision 6.4.0 Size  116,00MB
Park Systems XEC
|
59 |§5! Park Systems XEDE 150
Add New Ps
Programs &l Park Systems XEI
Click here for support information. Used frequently
Ej Last Used On 0
add{Remove To change this program or remove it from your computer, click Change/Remove, Change/Remave
Windows ————

Components ‘ Park Systems XEL
|§5! Park Systems XEL 1.4.2

@ -Y' Park Systems XEP 1.7.75.18 Size  165.00MB
5:'::':'5 el PDF Complete Size  29.37MB
Defaults P PI E-710 Host-Software Size  24.48MB
1[3;} Privacy Manager for HP ProtectTools Size  10.83MB
;(J Roxio Audio Madule Size  13.95MB

}_) Roxio Copy Module Size  14.53MB
‘Q Roxio Data Module Size  14.09MB

%{; Roxio DLA Size  240MB o

Lis .

Figure 1-2-1. ‘Add and Remove Program’ window

2. The ‘Uninstall Shield Wizard’ dialog will be opened. When ‘Confirm Uninstall
message box asks you again if you want to completely remove this ‘PSIA XEI

or Park Systems XEI’ program, click ‘OK’ to proceed uninstallation.
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€1 XEl 1.7.6 Uninstall M=
XE| Uninstall

&re you sure you want to completely remmove XEl and
all of its components?

Click Mext to continue, or Cancel to exit Setup,

[ Mest> | [ Cancel

Figure 1-2-2. Confirm Uninstall Message

3. The figure below will be shown when uninstallation is successfully done.
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&1 XEl 1.7.6 Uninstall M=
XEl Uninstall

2El was successfully reroved from your computer,

Figure 1-2-3. Confirm Uninstall Message

1-2-2. Installation of the new version ‘Park Systems XEI’ program

The procedure to install the new version ‘Park Systems XEI’ is as follows:

1. Insert the Unified XE-Software Installer CD and Installation Dialog will be

opened as seen in Figure 1-2-4.

10
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Excellence in Nanometrology a

‘}7 i Park Systems’

Software Installer

JRE Install |
XEP Install l
S|

BT (<) 2002-2008 Park Systems Corp. Al rights Reserved. Please contact Park Systems for more information.

Figure 1-2-4. Installation Dialog of Unified XE-Software Installer CD

2. The XEI software is run properly in Java SE Runtime Environment 6 or higher.

If necessary, install java program included in CD by clicking ‘JRE Install’.

3. Clicking ‘XEI Install’ opens following dialog.

11
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r

Lin= "Minjnen) Mid[rnm

-18.556

XEl

Image
Processing & Analysis

XEl is ready to be installed...

PM XE! Install

EEEETITEY (<) 2002-2008 Park Systems Corp. All rights Reserved. Pleasa contact Park Systems for more information

4.

Figure 1-2-5. Installation Dialog of XEI

Click “XEI Install’ to Install XEI program by following the steps below.

Stepl: Preparing to Install - Installation will start as shown as in Figure 1-2-6.
Step2: Installer Language — Choose the installer language in Figure 1-2-7.
Step3: Welcome to the XEI Setup Wizard - Click the ‘Next’ button to
continue the install setup as shown in Figure 1-2-7.

Step4: License Agreement — Read the License Agreement. You must accept
this agreement before continuing with the installation by checking ‘I accept
the agreement’ and click the ‘Next’ button to continue the install setup as
shown in Figure 1-2-7.

Step5: Select Destination Directory - The ‘Park Systems’ folder is made in
the C directory by this installation procedure. This is the base directory of XE

software. You may also select other destination in your computer by selecting

12
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‘Browse’. Click the ‘Next’ button as shown in Figure 1-2-7.

Step6: Select Start Menu Folder — Select the Start Menu folder in which you
would like Setup to create the program's shortcuts, then click ‘Next’ button as
shown in Figure 1-2-7.

Step7: Select File Associations — Select file association you want to creat e
and click ‘Next’ button when you are ready to continue as shown in Figure 1-
2-7.

Step8: Select Graphic Option — Select the graphic type according to your
graphics driver. If not selected correctly, the XEI program will not open
properly. The most common graphic type will be ‘OpenGL’.

NOTE!

If you select the wrong graphic type, the XEI program will not open properly.
To correct this problem, you must uninstall XEI completely and reinstall the program
again.

Step9: Select Additional Tasks — Check if you want to create a desktop icon

and click ‘Next’ button as shown in Figure 1-2-7.

13
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r

Elinstalldj Wizard

XEI is preparing the install4j Wizard which will guide
wou through the rest of the setup process,

| | cCancel
a
puEEy,
0“ e
XElnstall
X02-2008 Park Systems Corp. All rights Reserved. Please contact Park Systems for more information. ®, 3

*

* *
*
AT

Figure 1-2-6. Setup the ‘Park Systems XEI’ program
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License Agreement

Please read the following important information before ; Mé
continuing, SYSTEMS
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this agreement before continuing with the installation,

Park Systerns Corp, XE| Software License Agreement o]
2002-2008 Park Systerns Corp, &l rights reserved,
The enclosed computer program and the associated electronic
documentation {together called SOFTWARE) is licensed, not sold, to you
by Park Systerns Corp, for use only under the terms of this License, and
Park Systemns Corp, reserves any rights not expressly granted to you,
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e CT Cimriblio mf 1 Lk L

@ | accept the agreement
(| do not accept the agreement

un,
. .
o —
0

. .
< Back H Next>:‘] [ Cancel
v 3

S Setup - XEI 1.7.6

B
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It is recommended that you close all other
applications before continuing,

Click Mext to continue, or Cancel to exit Setup,

Setup - XEl 1.7.6

Select Destination Directory
Where should XEl be installed?

SYSTEMS

Select the folder where you would like XEl to be installed, then click Next,

Destination directary
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Required disk space: 28.7 MB
Free disk space: 18.472 MB
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K
+
.
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2 Setup - XEI 1.7.6

A Setup - XEl 1.7.6

Select Start Menu Folder Select File Associations

Which file associations should be created? ; M

SYSTEMS SYSTEMS

Select the Start Menu falder in which you would like Setup to create the
program’s shortcuts, then click MNext,

Where should Setup place the program’s shorcuts?

Select the file associations you want to create: clear the file associations you
do not want to create, Click Next when you are ready to continue,

| TIFF File: Format (= if)

AhnLab A TIFF File Farmat (=.tiff)
AutoHotkey
Daum
DocuPrint 2010 DN
doPDF &
Easy DWD CD Burner 2
Create shortcuts for all users
[[] Don't create a Start Menu folder
e, e,
:0' "‘ :0‘ “‘
1 = < Back [§| MNewt> = Cancel
< Back ‘.Next >’ . Cancel M. = ] [ ]
™
€2 Setup - XEI 1.8.0.Build16 EBE)X) | et setup - xE11.7.6

Select Graphic Option 7) 4 Select Additional Tasks P 5
Which graphic option should be selected? Wihich additional tasks should be performed?
Select the gdditiuﬂal tasks you would like Setup to perform while installing
© Option 1: OpenGL (Default) 54, e cllele s
© Option 2: Direct3D Create a desktop icon

sy
P %

[ < Back ][ Next > ] [ Cancel ]

- .
.

< Back H_ Mext > .:] [ Cancel ]
+ D

& Setup - XEl 1.7.6

&l Setup - XEl 1.7.6

Installing

7) E Installing P 5
Please wait while Setup installs XEl on your computer,

Please wait while Setup installs XEl on your computer,
SYSTEMS SYSTEMS

Uninstalling previous version

(

Extracting files, ..
LibWjai_codec.jar

(CLCLTITTTTTTIT

Figure 1-2-7. Procedure to install the ‘Park Systems XEI’ program

When the setup is completed, the ‘Completing the XEI Setup
Wizard’ window appears, click the ‘Finish’ button as shown in Figure 1-2-8.

When you have finished the XEI installation procedure, XEI folder
is created in the ‘Park Systems’ folder as a subfolder. Its shortcut will be

automatically created in your desktop and the ‘Park Systems XEI' program
will be made.

15
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€1 Setup - XEl 1.8.0.Build16 M=
Completing the XEl Setup Wizard

Setup has finished installing #El on yvour computer,
The application may be launched by selecting the
installed icons,

Click Finish to exit Setup,
Run xEl

Figure 1-2-8. ‘Completing the XEI Setup Wizard’ dialog
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Chapter 2. Menus & Toolbar

The Menu bar contains a list of all available menus from which you can
access the basic functions of the XEI image analysis program. Also, the most
frequently used menu items are provided as icons on the Toolbar. Figure 2-1 shows

the several menu items and the related icons.

¥ Open... Ctrl+0
= Ctrl+S
B save As.. ¥ Image
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s 4 4 &
1 Bxport... : i :
Print... Ctrl+P i i i
*" File Edit Mode MNavigator Analysis Process Effect Help
Preferences : : ; ;
i : : ) J
Exit Palette? |  Gray
: Gold
¥ ¥ ¥
9 Ctrl+Z Information B crop Brown
C Cirl+ Line “F Filter Aqua
Region P4 Flatten Cantrast
d?. . __ Grain 5 Deglitch Rose
= o PSD 24 Region Deglitch Melon
- - 3D Fourier Filter Terrain
# Delete  Delete Multi Tip Estimation Seismic
Select All Ctrl+A I3 Rotate & Flip Girby
Cyclic
5-Band
Sienna
Figure 2-1. Menu bar
2-1. File

Contains several menu items that allow you to Open, Save, Save As, Preview,
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Export, Batch Export and Print image data files as shown in Figure 2-1-1.

RN Edit Mode Mavigator Analysis Process Effect Help
?Qpen... Ctrl+0
=
Bl Save as.
" Preview
=3 Expart,..
£ Batch Expart, .
i Print,.. Ctrl+P

Freferences

Exit
Figure 2-1-1. File menu

2-1-1. Open

Opens the ‘Open’ dialog as shown in Figure 2-1-2. In order to bring an
image into the Analysis view, select the ‘File>Open’ in the Menu or click the ‘Open’
icon ! 1. Then, select the image file you want to analyze in the Open dialog. This
image file is loaded into the Navigator view. If the image file is the first file loaded into
the Navigator view, it is automatically loaded into the Analysis view of the Information
view. Otherwise, double clicking the image in the Navigator view loads the image

into the current analysis view.

Look in: |@ samples v| —? -ﬂ@“ﬂ
5 4] Cell .
ﬁ Channal Fihertiff
My Recent 4] Channel2
Documents | 4| cheese "

4] Doruco p ot |
@ ] Dupontt " a
Desktop ﬁ Dupont2 L ’ll ,

&

4|

g 4] GoldMine . o8 /f’
4] Mars T\
My 4] steelt
Documents
o Scan Source: Topography
eI’g Scan Mode: NC-AFM
. Data Size: 512 (=512 (pxl)
My Computer Sean Size: 10 (prmy=10 {m)
g File name: |F|ber.mT | [ :‘Oﬁn j
Tty Metweark T L ST
Places Files oftype: |Scan data file (* tiff, * tif) "@Mﬁ}e—‘

Figure 2-1-2. Open dialog
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2-1-2. Save Q

Allows you to save the processed image or result in the Image display panel
to the original image data file, overwriting the original data. When you select the
‘Save’ menu, the ‘Save’ warning message box as seen in Figure 2-1-3 appears to

remind you that this command may replace the original image file.

@ Do wou wank ko save the changes you made?

Shes N Mo
,% :

Figure 2-1-3. ‘Save’ warning message box

2

Opens the ‘Save As’ dialog as shown in Figure 2-1-4. In this dialog, you can

2-1-3. Save As

save the transformed image or statistics data as a new image data file. Unlike the
‘Save’ menu, it does not overwrite the data in the original data file but create another

data file.

ﬁ Save As E‘
Save in ‘E‘l samples vl ¥ J\@Hﬂ
2 ] Cell
; j Channel
My Recent ] Channel2
Documents 4] cheese

ﬂ Daruco
@ _4] Dupont!

Deskiop 2] Dupontz

1] Fiber
] 1] Guoldhine
3] Mars
hity .
4| steelt
_Documents &
My Computer
. .
l\:; File narme: Mars copytif] ‘ [!:J&:‘\g_i
hty Network B T d‘ﬂ
Places Files oftype  |scan data file (4, " 1if Vly—a%ve—‘

Figure 2-1-4. Save As dialog

2-1-4. Preview L,

Allows you to preview the processed image with its analysis data. You can

export and print this result in the preview mode. As an example of the preview
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screen, Figure 2-1-5 shows the preview screen of the selected image in the Line view.

5 & ciose

Stalistics
Line | MInGu | MAKCAT]: | MIGur | Meanian) | Rangetums | RMSGIn. | H Suduos
WRed 300 0@ 198 213 21 07 (5

Figure 2-1-5. Preview screen

s

2-1-5. Export 1

Allows you to export the data file as a Portable Network Graphics(PNG) file, a
Bitmap Image(BMP) file and a Joint Photography Experts Groups(JPEG) file. This
‘export’ file format is selected by default considering the images’ quality and size. In
order to export the data file, select click the ‘Export’ option in the File menu or clicking
the ‘Export’ icon =4 and find the directory you want to export the data file. Then,
save this file as a new file name. Figure 2-1-6 shows the procedure to export your

data file in the ‘Export’ dialog.
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()

Save in (L) My Documents Lﬂl Q -‘

c nts
a iy Computer
Local Disk (C)
|3 Shared Dacuments
2 CD Drive (D)

File name: |Nnname phgy ‘ [ Open ]

Files oftyne'  |Expartfile {~png) v

(b)

Save in ‘h samples "l 5] D‘l

File name: l@@png I Save
Filez oftype:  [Eypart file 1~ prg) b

(©

L Export |X|

Save in: Ij Dl‘
Filename:  |Line analysis 1 of Mars.png | [_sa
Filas aftype: \Expmme -.png) + [Save selected fils

Figure 2-1-6. Export dialog
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2-1-6. Print =

Allows you to print the selected view. Before printing, you can preview the

newly processed image or analysis data in the preview screen. This preview can be

printed by selecting the ‘File>Print’ or clicking the printicon =",

2-1-7. Preferences

Through the ‘preferences’ menu, you can change several settings in

accordance with your preferences.
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&l Preferences §|

Language
(#) English () Systern Locale

Fenderer
() OpenGL (%) Direct3D

Use Move Tool
[ ]Line
] Region{Flatten, Fourier Filter)
Deglitch

Freview

Background:

[] Show barder

Mavigator

[] Show warning whenever loading a new image

Irnage
(# Real Bize (O Fitin Sguare

Spectroscopy
[] Auta Offset
Line
[]Usze Three Lines

Palette
[ ]Fixed FPalette

Falette -
[ ] Fixed Palette Range
- {nm. deg. W, nh, n&j
[ ] Fized Data Range
~ inm. deg. ¥, nM, na)

| Restore Defaults | | Close |

Figure 2-1-7. Preferences Dialog

The settings that can be changed from the ‘Preferences’ window are
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e Language for the XEI software. English or language of your computer
system OS (Currently Korean and Japanese are supported)

e The type of 3D Renderer(OpenGL, Direct3D) suitable for your system.

e The type of Move Tool you wish to use

e Background color and border settings of the image data files that are
created when the analysis view is exported

e Notify the user when a new image is being loaded for analysis

e Preserve the original image’s dimensions, or fit them into a square

e Add a constant value to Spectroscopy data for normalization

e Use multiple (up to 3) lines for analysis in Line View(As default, it is
not unchecked and you can use two lines).

e Change original condition of palette(color of palette, palette range,

palette data range).

2-1-8. Exit

You can close the XEI program by selecting the ‘File>Exit’ menu. Then, the

‘Exit’ confirmation message box appears as seen in Figure 2-1-8.

@ Da you really want to close this application?

G

Figure 2-1-8. ‘Exit’ confirmation message box

2-1-9. Batch Export B4

Batch Export icon will allow users to export the screen or displaying image, as
an “Enhanced Meta” file or “.emf” file (one of the vector file formats). Vector file format
contains each shape’s geometric information, and displays the best resolution of
screen image, whereas previous versions of XEI, the saving file resolution depended
on size of screen display. Hence, when saving the screen display files as an “*.emf”
file, the resolution quality will maintain its visual quality. This image file separates

information for line, shape, and color’'s graphic components. In order to export the
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screen display image as an “.emf” file, select the ‘Batch Export’ option in the File menu
or click the ‘Batch Export’ icon =4 and locate the directory where data will be saved.
Then save the file with a new file name. Figure 2-1-9 shows the procedure to export
data file in the ‘Batch Export’ dialog.

(@)

(] Export
Save in (53 My Documents Lﬂl 5] -‘|

9 Nty Computer
e Local Disk (C)
|3 Shared Documents

2 CD Drive (DY)

I
Documents

B
g

- File name: |Fibev ‘[ Open ]

Files oftype |\Enhanced Meta file(.emf) v‘ Cancel

(b)

L Export
Save in ‘E) samples Vl 5] D‘l

by
Documents

L JB
k]

-
- File name lf I Save
Files oftype:  |Enhanced Meta file(,emf) B

(€)
L Export

Save in

Iy
Documents

-

o

- LLLTY
- 03
-« File narme: I Line analysis 1 of Mars I

Tl
Files of type |Enhanced Meta file(,emf) v [Save selected fils

Figure 2-1-9. Batch Export dialog
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2-2. Edit

Has common function necessary to edit the image for processing and analysis.

Figure 2-2-1 shows several Edit menu items.

Filemr‘ﬂode Mavigator Analysis Process Effect Help
dj

Ctrl+Z
C Ctrl +Y
JB Ctrl +%
= Ctrl+C
.-__h:| Ctrl +v

> Delete Delete
Select all Ctrl+4

Figure 2-2-1. Edit menu

2-2-1. Undo

Undoes the previous command.

2-2-2. Redo

Redoes the previous command.

2-2-3. Cut
Cuts the selected line or region related to analysis of the image.
2-2-4. Copy

Copies the selected line or region in the image.

2-2-5. Paste

Allows you to paste the cut or copied ‘line or region’ to the location of your

choice

2-2-6. Delete

Deletes the selected line or region of the image in the Analysis view.

2-2-7. Select All

Selects all lines or regions in the image.
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2-3. Mode

Used for switching between Image and Spectroscopy modes.

2-3-1. Image

This item enters Image Mode. Except for Chapter 18, Spectroscopy Mode,

this manual assumes that XEl is being used in Image mode.

2-3-2. Spectroscopy

This item enters Spectroscopy Mode. Used for analysis of F/D and I/V
spectroscopy curves, Spectroscopy Mode is explained in further detail in Chapter 18,

Spectroscopy Mode.

2-4 Navigator

2-4-1. Show Navigator

User can choose to show or hide the Navigator View through this command.

2-5. Analysis

The Analysis menu provides you direct access to carry out quantitative
analysis of the selected line, region, grain and PSD of an image and to view the 3D
rendered image. As shown in Figure 2-5-1, the Analysis menu has seven items:
Information, Line, Region, Grain, PSD, Surface, Fractal, 3D, and Multi. You can start
any one of these analysis by selecting the option in the Analysis menu or by clicking

the corresponding tab below the Toolbar.
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File Edit Mode MNavigator BEGEIREEN Process Effect Help

Information

Line

Beqgion

Grain

B5D

surface

Fractal

an

BAulti

Infarmation | Line | Region| Grain| PSD | Surface | Fractal | 30| Multi

Figure 2-5-1. Analysis menu and tabs

2-5-1. Information

In the Information view, you can display the 2D image with basic information
of the image that you selected from the Navigator view or loaded by using the ‘Open’
dialog. The Information view shows the original image and much of the scan
information associated with the image data. Figure 2-5-2 shows the Information view
of the selected image. The Information view is described further in Chapter 3.

“Information View”.
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Information |Line | Region | Grain | PSD| 3D | Multi

Hm Fibertiff
F File Name
254 PSIATIFF Version
Comments
- Head Mode
¢ XY Voltage Mode
ZVoltage Mode
Z Scanner Range
Source

10

Low Pass Filter
Plain Fit
Flattening

Data Width
Data Height
Sine Scan
Over Scan

XY Servo Mode
Fast Scan Axis
Fast Scan Dir

o

Slow Scan Dir
X Scan Size

Y Scan Size

X Scan Offset

Histogram ¥ Scan Offset
Rotation
Scan Rate

;“7 SetPoint

05 1 15 2 25 Tip Bias

Sample Bias

Data Gain

Z Servo Gain

400 pulidiv

Fibertiff
1.02

NC-AFM
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1
Topography
0

off

None
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of

0(%)
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X

Rightto Left
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3.56 (um)
7.35 (um)
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0(H)

0 (unit)
om

om
-132.43E-6 (um/step)
0

Hide Details

Figure 2-5-2. Information view

2-5-2. Line

In the Line view, you can get information about the cross section or height

profile of the surface in the selected image. You can see a Line Profile, a Power

Spectrum, and a Line Histogram of a selected line, all at one time.

Also, the surface

statistics table of the selected line is displayed. Figure 2-5-3 shows the Line view of

the analyzed image. A more detailed description of the Line view is offered in

Chapter 4. “Line View”.
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Information | Line | Region | Grain | PSD| 3D | Mult
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Figure 2-5-3. Line view

2-5-3. Region

In the Region view, you can get information about a region of the sample
surface in the selected image.
region as well as a surface Statistics table such as the maximum and minimum height
value, mean height and RMS roughness.

analyzed image. A more detailed description of the Region view is offered in Chapter 5.

“Region View”.

You can see a Region Histogram of the selected

Figure 2-5-4 shows the Region view of an
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2-5-4. Grain

In the Grain view, user can perform grain analysis on the loaded image.
System automatically detects grains in the image, calculates important surface profile
parameters of each detected grain, and displays the distribution of surface parameters
among detected grains  Figure 2-5-5 shows the Grain view of an analyzed image. A

more detailed description of the Region view is offered in Chapter 6. “Grain view”.
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Figure 2-5-5. Grain view

2-5-5 PSD

In the PSD view, user can analyze roughness of the sample surface through
PSD graph of the loaded image and obtain relevant data. Figure 2-5-6 shows the
PSD view of an analyzed image. A more detailed description of the Region view is
offered in Chapter 7. “PSD View”.
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Figure 2-5-6. PSD view
2-5-6. Fractal

In the Fractal view, user can analyze fractal dimension of the sample surface
through fractal graph of the loaded image. Figure 2-5-7 shows the Fractal view of an

analyzed image. A more detailed description of the Fractal view is offered in Chapter 8.
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Figure 2-5-7. Fractal view
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2-5-7. Surface

In the Surface view, user can analyze surface area of the sample image in the
selected image. You can collect surface statistics such as geometric area, surface
area and surface area ratio. Figure 2-5-8 shows the Surface view of an analyzed

image. A more detailed description of the Surface view is offered in Chapter 23.

Surface Statistics

Geometric Area (um2): 100.0000

Surface Area (um?): | 1950613

Filter : | None v

Surface Area Ratio (%4): | 95,0613

i)

Angle Statistics

a5 (%) | 44,5301

Filter : |None vl

=
z
2
3
3

400 puiidiv

Figure 2-5-8. Surface view

2-5-8. 3D

In 3D view, you can view and generate 3D rendered images using many

display parameters. The 3D view helps you to see the features of the image and the

relationships between those features more clearly. Figure 2-5-9 shows the 3D view

of a 3D rendered image. The 3D view is discussed more in Chapter 9.
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Information | Line | Region | Grain | PSD| 3D | Multi
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Figure 2-5-9. 3D view

In Multi view, you can display and print out several images, up to 6 at a time,

with their file name and the palette panel for the contrast and adjustment of the

images.

You can load multiple images into the empty display panel.

Figure 2-5-8

shows the Multi view of the selected images from the Navigator view. A further

detailed description is provided in Chapter 10. “Multi View”.
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Figure 2-5-10. Multi view
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2-6. Process

The Process menu offers you eleven image processing tools: Crop, Filter,
Flatten, Deglitch, Region Deglitch, Fourier Filter, Tip Estimation, Rotate & Flip, Pixel
Manipulation, Unary Arithmetic, Binary Arithmetic and Stitch as shown in Figure 2-6-1.
Commonly, this Process menu provides several controls for improving image
resolution or removing artifacts such as high or low frequency noise, curvature, tip
effect and glitches from an image without modifying the actual surface features.
Several process dialogs are implemented. You can use one of them from the Process

menu or click the icon from the toolbar. .

File Edit Mode Effect Help
T Crop

= Filter

L Flatten

24 Deglitch

24 Region Deglitch
Fourier Filter

Tip Estimation
I¥ Rotate & Flip
E32 Pixel Manipulation
Yea Unary Arithmetic
"+ Binary Arithmetic
afitch

BGteEAREGS

Figure 2-6-1. Process menu and Toolbar

2-6-1. Crop &

In the Crop process dialog, you can crop a part of an image which is a region
of interest. Figure 2-6-2 shows the Crop process dialog. The Crop menu is

described more in Chapter 11. “Crop”.
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Figure 2-6-2. Crop process dialog

2-6-2. Filter &

Using the Filter process dialog, you can remove some artifacts from the

sample surface that are not real data. Figure 2-6-3 shows the Filter process dialog.

A further detailed description is offered in Chapter 12. “Arithmetic Filter”.

(o]

Method

MName: Gaussian Blur v

Parameters

Kernel X Size: |7 v‘
Kemeiv s

[] Equal Size

Std. Y 5 8
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Cancel

Figure 2-6-3. Filter process dialog
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2-6-3. Flatten °*

In the Flatten process dialog, you can remove curvatures and slopes from
your image data. For more information about the Flatten processing feature, you can
refer to Chapter 13. “Flatten” in this document. Figure 2-6-4 shows the Flatten

process dialog.

um

3]

X qoOe

Parameters

Scope: | Whole v

Orientation: | Axis v

Regression Order: |1 v

[ Reload cancel |

Figure 2-6-4. Flatten process dialog

2-6-4. Deglitch ™

In the Deglitch process dialog, you can remove small glitches or vertical and
horizontal streaks in an image. Figure 2-6-5 shows the Deglitch process dialog.

Deglitch is described further in Chapter 14. “Deglitch”.
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K5 Deglitch

nm
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Figure 2-6-5. Deglitch process dialog

2-6-5. Fourier Filter

In the Fourier Filter process dialog, you can use the Fourier Filter to remove
unwanted frequency components from your data. About the Fourier Filter, consult

Chapter 16. “Fourier Filter”. Figure 2-6-6 shown below is the Fourier Filter process

dialog.
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Figure 2-6-6. Fourier Filter process dialog
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2-6-6. Tip Estimation -~

In the Tip Estimation process dialog, you can estimate the shape of the tip
used to obtain the image and remove the artifacts generated by tip shape (known as
‘Tip Convolution’) from the loaded image to obtain more accurate image. Consult
Chapter 17 for more information on Tip Estimation. Figure 2-6-7 shows the Tip

Estimation process dialog.

K& Tip Estimation

20

Save

16

300 -
©
100 Parameters
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Priority: | Accuracy vJ
Tip Size: =l

0 o ‘ Equal Size

4 8 12 16 20

0 100 200 300 400
nm

e [

Figure 2-6-7. Fourier Filter process dialog

2-6-7. Region Deglitch i |

In the Region Deglitch process dialog, you can remove small artifact in an
image that does not represent the true surface topography to obtain more accurate
image. Consult Chapter 15 for more information on Region Deglitch. Figure 2-6-8

shows the Region Deglitch process dialog.
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&1 Region Deglitch §|

nm
1507 |
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nm
400
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[ Execute | nda [ Redo |

[ Feload | 0K Cancel

Figure 2-6-8. Fourier Filter process dialog

2.6-8. Rotate & Flip 1=

In the Rotate & Flip process dialog, you can change the orientation of the
obtained image. It may be helpful comparison of images taken at different orientations.
Consult Chapter 18 for more information on Rotate & Flip. Figure 2-6-9 shows the

Rotate & Flip process dialog.
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51 Rotate & Flip X
b Method - —
L Name: |Flip gJ
Parameters —
Orientation: X \ﬂ

100

50 -.—

0.

-50
-100

[ Reload__J [ 0K ] [ Cancel |

Figure 2-6-9. Rotate & Flip process dialog

. . . Eﬂ
2-6-9. Pixel Manipulation FEer=

In the Pixel Manipulation process dialog, you can increase or decrease the
number of pixels in the obtained image. This is useful when comparing images of
differing resolutions. Consult Chapter 19 for more information on Rotate & Flip.

Figure 2-6-10 shows the Pixel Manipulation process dialog.
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&2 Pixel Manipulation ]‘ZI
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Current Pixel
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Figure 2-6-10. Pixel Manipulation process dialog

. A
2-6-10. Unary Arithmetic w2

In the Unary Arithmetic process dialog, you can perform arithmetic operation
on image such as invert, square and square root. Consult Chapter 20 for more
information on Unary Arithmetic. Figure 2-6-11 shows the Unary Arithmetic process

dialog.
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Figure 2-6-11. Unary Arithmetic process dialog

2-6-11. Binary Arithmetic

In the Binary Arithmetic process dialog, you can perform arithmetic operation
on two images such as +/-. It may be useful for the direct comparison of two images.
Consult Chapter 21 for more information on Binary Arithmetic. Figure 2-6-12 shows

the Binary Arithmetic process dialog.
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& Binary Arithmetic

nm

Method

20

300 4

16

200 4

12

pm

-

100

N -
A - ‘
’ .
-
8 12 16
um

4

&\ O .

Drag image to f

A

20

[ Reload ] | 0K ] [ cancel ]

Figure 2-6-12. Binary Arithmetic process dialog

2-6-12. Stitch

In the Stitch process dialog, you can stitch several images together and make
an image. It may be useful that you want to get a bigger sized image than the obtain
image. Consult Chapter 24 for more information on Stitch. Figure 2-6-13 shows the

Stitch process dialog.
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Figure 2-6-13. Stitch process dialog

2-7. Effect

2-7-1. Palette #

You can select the palette that is to be used for the contrast adjustment in the

‘Effect>Palette’ menu or by clicking the ‘Palette’ icon =,

File Edit Mode Mavigator Analysis ProcessHeID

Gray
Gold
Brown
Aqua
Contrast
Rose
Melon
Terrain
Seismic
Girby
Cyclic
5-Band
Sienna
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Figure 2-7-1. Effect menu

2-8. Help

2-8-1. About

This item opens a dialog with information(Version and build data) on this

program.
About XEI [X]

'61 Yersion: 1,76

L% Build ID: 20100222

2002-2009 Park Systerns Corp,
&ll rights reserved,

Figure 2-8-1. About dialog
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Chapter 3. Information View

In the Information view, the loaded image and its essential information, such
as the scan conditions and parameters that were used in acquiring data, are displayed
on the XEI screen. You can preview the original image and data through the

Information view before performing an image processing or analysis.

Palette Panel Image Display Panel Information Table

1
Information l:ine Region  Grain| PSD| 3D Multi

1

1

1

1

1

1 1

um Fibey tiff v

i
- 2 - 1
ot File Name Fiber.tiff
25 .* v hild PSIATIFF Version 1.0.2
Comments
2 Head Mode NC-AFM
q XY Voltage Mode  High
24 ZVoltage Mode High
ZScannerRange 1
© Source Topography
154 Low Pass Filter 0
o E Plain Fit off
Flattening None
- Data Width 512 (pxl)
L Data Height 512 (px)
Sine Scan off
Over Scan 0(%)
05 At XY Servo Mode On
Fast Scan Axis X
Fast Scan Dir Rightto Left
Slow Scan Dir Top to Bottom
u = X Scan Size 10 (um)
Y Scan Size 10 (um)
X Scan Offset 3.56 (um)
AL ¥ Scan Offset 7.35 (um)
E Rotation 0 (deqg)
E Scan Rate 0(H)
2 A‘i SetPoint 0 (uniy
0 05 1 135 2 25 Tip Bias owv
4 HD Sample Bias oV
: Data Gain -132.43E-6 (umistep)
1 Z Servo Gain 0

Histogram Plot

Figure 3-1-1. Information view
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3-1. Information View

The Information view is automatically enabled when you execute the XEI
program, but you can switch to the Information view from other views by selecting
‘Analysis>Information’ in the Menu or by clicking the Information view tab below the

menu bar. Figure 3-1-1 shows the layout of the Information view.

3-2. Palette Panel

The Palette Panel is used to adjust the contrast level range of an image. The
Palette panel displays the range of the image data values of the measured signal.
Also, the Palette panel shows the relationship between the color of the pixel in the
image and corresponding data values of the measured signal. Different colors or
shades in the Palette panel represent different height values of the data in the image.
The default palette is based on gold color palette scale in which darker colors indicate
lower heights and the brighter colors indicate higher height values. As shown in the
Figure 3-2-1, there are 3 cursors in the scale bar that indicates the level and range of

the scale bar and can be adjusted.

Color
palette

A

2 - - - - - Contrast
range (max)

=)

O ~0 O

1.5 met------ Contrast level
(red line)

. == === Contrast
Range (min)

Edit Data Range...

Full Data Range

o s o O

0.5

L Change Palette  »
Full Palette Range
Auto Palette Range

Cntai — (1]

Figure 3-2-1. Palette Panel
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3-2-1. Data Range Adjustment

On the left side of the Palette panel, the vertical data scale indicates the
height range of the image. By default, maximum (minimum) value of the data range
corresponds to the maximum (minimum) data of the pixel data. This data range can
be edited manually by ‘Edit Data Range’ command in the context menu of the palette

panel.

B Full data range

Full data range command automatically sets maximum (minimum) value of the

data range to the maximum value of the pixel data.

3-2-2. Contrast Range Adjustment

There are two cursors in the palette panel that helps users to change the
contrast range. They are Contrast Max and Min cursors. The contrast range is set by
adjusting the vertical length of the color palette by dragging these two cursors. Also
contrast range can be adjusted by ‘Full Palette range’ command in the context menu

of the palette panel.

B Contrast Max cursor

‘Contrast max’ cursor indicates the data value on the data scale that
corresponds to the brightest color of the current color palette (generally white). Any
pixels with the data value that exceeds the value indicated by ‘Contrast range max’ will
be displayed in brightest color of the color palette (generally white) regardless of their

value.

B Contrast Min cursor

‘Contrast min’ cursor indicates the data value on the data scale that
corresponds to the darkest color of the current color palette (generally black). Any
pixels with the data value that is under the value indicated by ‘Contrast range min’ will
be displayed in darkest color of the color palette (generally black) regardless of their

value.
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B Full Palette Range

Full palette range command automatically brings ‘Contrast Max’ cursor to the
maximum value of the data range and ‘Contrast in’ cursor to the minimum value of the
data range. Therefore, Full palette range command adjusts contrast range such that
the contrast range matches the full range of the data range. Thus, the scale maximum
corresponds to the data maximum and the scale minimum corresponds to the data

minimum.

Adjusting contrast range is useful when you are interested in a specific height range in
an image. You can narrow the contrast range so that it covers smaller features in an
image (Figure 3-2-2). In this way, you can scale up a specific height range in an

image to see smaller features in greater detail.

B Auto palette range

The contrast range can be automatically determined by the XEI program.

Double click on the contrast bar to set the contrast range with this feature.

nm MouseSperm tiff nm MouseSperm tiff

0

Figure 3-2-2. Contrast range adjustment

3-2-3. Contrast Level Adjustment

‘Contrast level marker’ is a red line on the palette panel. ‘Contrast level
marker’ indicates the data value on the data scale that corresponds to the middle of

the current color palette. As shown in Figure 3-2-3, the contrast level is adjusted by
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click and dragging the ‘Contrast level marker’ on the palette panel.

a) b)

um Channel tiff um Channel tiff

Figure 3-2-3. Contrast level adjustment

3-2-4. Palette Change

You can change the palette for the contrast adjustment by selecting the
‘Palette’ option in the Effect menu (see Figure 2-6-1).

+
o+

3-2-5. Enhanced Color

The Enhanced Color button changes the way colors are displayed. In the
Enhanced Color scheme, the color of a pixel is determined by how much of a change
it has compared to its neighbors. Therefore, it is not linearly representative of the
data. You can toggle Enhanced Color using the #! button. Enhanced Color also

has its own palette, accessible by right-clicking the Enhanced Color button.

Pentacene

nm
nm = Pentacene

"
S

Figure 3-2-4. Enhanced Color
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3-2-6. Zoom In/Out 4 =

Loaded images can be zoomed in by clicking the %4 icon and can be

zoomed out by clicking the 24 icon. Adjusting the mouse wheel can also be used to

increase or decrease the zoom percentage. The zoom percentage of the original

image size is set to 100%, this is the minimum percentage that the image can be

zoomed out to. The zoom percentage is displayed at the upper right corner of image

display panel. The image resulting from the zoom in or out will be displayed within

scan image display. Due to the size of the display, some of the image area will not

be visible. The panning tool can be used to change the available visible area by

adjusting the image offset.

IR P Zoom : 100% ) Cb] zoom : 143

deg

20
um

Zoom © 100%

AWE Y o) O
deg L 2

Figure 3-2-5. (Upper) Zoom In, (Down) Zoom Out

1| Zoom : 143%

4 Zoom :100% 1
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To bring up the panning tool, click the wheel button after putting the cursor

on the image, and the ET? icon will be appear. At this time, drag a location on the
image to a different position.

NiCoAlloy W 0] Zoom:148%  geg NiColloy 2 0] Zoom : 149%
&

A e

] &7 £ [

¥

0 =i

20

-40

s
S
15 20 2!

Figure 3-2-6. Pan

3-3. Image Display Panel

As shown in Figure 3-3-1, the Image display panel shows the 2D image you

selected in the Navigator view.

3-3-1 Loading Image to the Image Display Panel

When you want to change the image in this panel, you can double-click
another image in the Navigator view. At this time, you can see the ‘Load’ confirmation

message box which asks if you want to initialize the selected image (Figure 3-3-2).
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- - - File Name
v
Fiber tiff
. Context
Scan Height - - ¥ menu
- - -~- Scan Width
Histogram
Histogram - - » % l IA
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um

Figure 3-3-1. Image display panel of the Information view

1 ) This will initialize all analysis views, Do you want to continue?

J .

-

-

\I Ye
\\
——

Figure 3-3-2. ‘Load’ confirmation message box

3-3-2 Export

Tiff files, loaded in XEI, can be exported in the form of a text file or an image
file (jpg, png, bmp, and emf) from the ‘Export’ command in the context menu of the
Image display panel. The raw tiff file consists of two parts, the scan data and the
image. When the tiff file is exported as a text file, the file will contain basic information
about the tiff file and the data array of the scan data. On the other hand, when the tiff
file is exported as an image file, the exported image file only includes the image of the

tiff file but not the scan data within it; the image will not include any dimensional
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information.

3-3-3 Copy to Clipboard

This command copies the scan data onto the clipboard as a text file or an
image. Text files will contain basic image information and the data array. The
command will copy an image file to the clipboard. Right click on the image to open
the context menu in the Image display panel. From the ‘Copy to Clipboard’
command in the context menu, choose text or image, then paste the copied data in

the corresponding document file by clicking [Ctrl+V] button.

3-3-4 Histogram

The Histogram shown below (Figure 3-3-3) is a bar graph that shows the
distribution of heights along a height profile. When you load an image, a histogram is

automatically displayed.

The x axis represents the height of data points in the sample surface and its
unit can be A, nm, um and so on. The width of a bar depends on the overall height
range of the sample and the number of data points of the line profile. The y axis is the

number of data points with the same height values and its unit is pixel.

Histogramm

400 pxlidiv

-1 05 0 05 1
Hm

Figure 3-3-3. Histogram

When right click on Histogram, menu will pop-up. Below is context of menu.

B Use Gaussian Fitting

It displays a Gaussian Fitting curve of height distribution, according to the
function below, on histogram chart. Gaussian Fitting curve contains;
a: Number of pixels according to m,
m: Average,

o: Average deviation.
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Gaussian curves can be useful for acquiring height data from the image

Histogram.
_(x-m)?
f(x) =ae 20
Histogram ) o a=11159, m=-7.34, o= 75953
. pGaussian Fitting Curv
§ !
z N
5 \
w t =
(o] ™ —
-100 -50 0 50 100 150
nm

Figure 3-3-4. Cursors on Histogram

Cursors can be placed on the Histogram to acquire single point data.
Paired cursors can be placed on the Histogram to acquire distances between two
areas of the Gaussian function. After adding the cursor(s), the cursors can be

dragged to different positions on the Histogram.

B Export

Same as Export feature in Image Display panel. Refer to Section 3-3-2.

B Copy to Clipboard

Copies the histogram data to the clipboard as a text file (txt) or an image file.
Open the context menu by right clicking on the histogram, choose the ‘Copy to
Clipboard’ command in the context menu and paste the data in the corresponding

document file by clicking [Ctrl+V] button.

B [nsert a Cursor

Insert a single cursor on the histogram, similar to Line Profile panel. Up to three
single cursors can be added. In figure 3-3-5, below, two single cursors are shown on
the histogram. Numbers in the rectangle indicate each single cursor’s X, Y position.

Red single cursor indicates (22.116nm, 38.841pxI).
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Histogram
=T {34.561,218.75)
z]
= [(22.116, 38.841)
D -+
L
20 25 0 35 40
nm

Figure 3-3-5. Cursors on Histogram

B Delete a Cursor

Deletes a selected cursor, similar to Line Profile panel.

B Delete all Cursors

Deletes all of the added cursors, similar to Line Profile panel.

B Insert a Cursor Pair

Inserts a cursor pair, similar to Line Profile panel. Currently, three cursor pairs can be
added. Figure 3-3-6 below is shown with one cursor pair inserted in the histogram.
The numbers in the rectangle indicates the difference between the cursor pair. The

X and Y differences are 113.026nm and 3362pxI respectively.

Histogram

=

= S

= | -

2 ——

= Y —

“:"_ e _—— e e e o
-50 -25 't 3-890 25

Figure 3-3-6. Cursors on Histogram

B Delete a Cursor Pair

Deletes a selected cursor pair, similar to Line Profile panel.

57



XEI Software Manual

B Delete all Cursor Pairs

Deletes all added cursor pairs, similar to Line Profile panel.

3-4. Information Table

When scan image file is generated from XEP software, various information
and scan parameters used to obtain image is saved along with the image itself. As
shown in Figure 3-4-1, these can be viewed through the Information table. Clicking
‘Show Details’ button will display every information and parameters saved with the
image. Click ‘Hide Details’ button to view only the important information and
parameters, summarized. Meaning of the each items found in the Information table is

given in the Table 3-1.

File Mame 08um.tiff
Head hMode - AF bt
Source Topography
Data Width a12 (pxh

Data Height a12 (pxh
¥ Bran Size 9.04 {prm)
Y Scan Size Q.04 {prmy

Scan Rate 0 iHz)
Set Point 0 {unit)
Data Gain -145 B7E-6 (pmistep

Figure 3-4-1. Information table (Hide Details)

Table 3-2. Items in the detailed Information table

Item Meaning

File Name Indicates the file name of the generated image that was
saved after scanning.

Version Indicates the version of Park Systems software that created

the image file. XEI 1.8.0 supports tiff file below 1.0.2

Date Time Shows the time and date at which this file was created.

Comments Shows the comments you edited in the Image Information
dialog of the XEP or XEI.

Head Mode Indicates the Head mode such as AFM, NC AFM, MFM,

LFM, EFM, FMM and so on. It was selected in the XEP

Part Selection dialog.
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Information View

XY Range
Mode

Z Range
Mode

Z scanner
range

Source

Low Pass Filter

Plain Fit

Flattening

Data Width

Data Height

Sine Scan

Over Scan

Fast Scan Axis

Indicates the scan range mode of the XY scanner (Large,
Medium or Small) during imaging. This parameter is set in
the Part Config dialog box of XEP.

Indicates the scan range mode of the Z scanner (Large or
Small) during imaging. This parameter is set in the Part
Config dialog box of XEP.

Indicates the range of Z scanner (0 to 1 corresponding to O
to 12um range of the Z scanner) during imaging. This
parameter is set from the Part Config dialog box in XEP
Indicates the input signal source that was used to acquire
an image. This Source was selected in the Input
Configuration dialog of the XEP image acquisition software.
Indicates the time interval used to generate the averaged
data pixel so that high frequency noise can be eliminated.
The higher value of the LPF means that a longer time
interval is permitted to generate each pixel. This
parameter was adjusted in the Input Configuration dialog in
XEP.

When turned On, Plain fit keeps the average level of each
line of data constant so that the contrast scale does not
saturate while an image is being generated.  This
parameter was selected in the Input Configuration dialog.
Shows the type of flattening applied to the image during
data acquisition process, if any flattening was selected from
the Input Configuration dialog.

Indicates the pixel size of an image in the x direction. This
parameter was selected in the Scan Configuration dialog.
Indicates the pixel size of an image in the y direction. This
parameter was selected in the Scan Configuration dialog.
When it is On, indicates that the sine scan was applied to
an image while scanning. This parameter was selected in
the Scan Configuration dialog.

Indicates the percentage that an over scan was applied to
an image while scanning. This parameter was selected in
the Scan Configuration dialog.

Indicates the scan direction that was selected to acquire
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Fast Scan Dir

Slow Scan Dir

X Scan Size

Y Scan Size

X Scan Offset

Y Scan Offset

Rotation

Scan Rate

Set Point

Amplitude

Sel Freq.

Tip Bias

each line of data in compiling the image. This parameter
was selected in the X, Y check box in the Scan control
window of XEP.

If the fast scan axis is X, indicates that the fast scan
direction is from left to right or from right to left.

If the fast scan axis is X, indicates that the slow scan
direction is from bottom to top or from top to bottom.
Indicates the scan size of an image in the x direction. This
value was set in the Scan control window of XEP.

Indicates the scan size of an image in the y direction. This
value was set in the Scan control window of XEP.

Indicates the X offset coordinate relative to the scanner
midpoint (0, 0) that was used to define the scan area. This
value was set in the Scan control window of XEP.

Indicates the X offset coordinate relative to the scanner
midpoint (0, 0) that was used to define the scan area. This
value was set in the Scan control window of XEP.

Indicates the degree of rotation that the fast scan direction
was rotated relative to the X axis or the Y axis while an
image was generated. This parameter was adjusted in the
Scan control window of XEP.

Indicates the frequency that the scanner is rastering back
and forth across the sample surface. This parameter was
adjusted in the Scan control window of XEP.

Indicates the set point value adjusted in the Scan control
window or Frequency Sweep dialog. Depending on the
scan mode, the meaning of this value may differ for different
scan modes.

The amplitude at which the cantilever was modulated during
NC-AFM mode images.

The frequency at which the cantilever was modulated during
NC-AFM mode images.

Indicates the voltage that was applied to the tip with the
sample being grounded to investigate the interaction
between the tip and sample while scanning. Depending on

your instrument, either a tip bias or a sample bias can be
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Sample Bias

Data Gain

Z servo gain

applied. This can be adjusted in the Scan control window
of XEP.

Indicates the voltage that was applied to the sample with
the tip being grounded to investigate the interaction
between the tip and sample while scanning. Depending on
your instrument, either a tip bias or a sample bias can be
applied. This can be adjusted in the Scan control window
of XEP.

The real data is obtained by multiplying the raw data and
data gain itself.

Indicates the value of Z servo gain set during the imaging

process.
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Chapter 4. Line View

In the Line view , you can measure and analyze several characteristics of an
image along selected line profiles. Select the line type (for example, vertical, horizontal,
or slanted), and generate the line (up to 3 if ‘Use Three Lines’ is selected in
‘File>Preferences’ ) on the image across the profile you want to measure and analyze.
You can make quantitative measurements of surface features and collect surface
statistical data along the cross section. The Line view provides a Line Profile, a Power

Spectrum, and a Histogram of the line profile.

In general, you can analyze the selected lines in your image in the Line view

through the following steps:

1. Select an image you want to analyze in the Navigator view.

2. Enable the Line view

3. Click the desired line type button on the line selection toolbar that is at
the higher right side of the displayed image.

4. To draw a line, drag the mouse across the profile you wish to analyze.

5. The measurement results will appear in several panels and a statistics
table.

6. Save and print your Line view results if desired.

Figure 4-1 shows the summarized procedure to analyze the selected line in an image.

63



XEI Software Manual
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Figure 4-1. Procedure for Line view
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4-1. Line View

To enable the Line view, select ‘Analysis>Line’ from the menu bar or click the
Line analysis tab below the Toolbar. The layout of the Line view is divided into three
main regions; Image display panel, Analysis plots panel, and Statistics table. Figure

4-1-1 shows the Line view of the horizontal line in the image.

Palette Panel  Image Display Panel Line Selection
1 1 Toolbar
1 1
1 I

I
]
]
information| Line |Region | Grain | £SD | 30} Multi 1

————
= g [XN—| =0 < |
Tine Profile. Blue
1251 “25
1
. 00
s
100 3 * *50
i
25
0
1 3 4 5
75 pm
Power Spectrum: Blue
50 2563
o %3
E 1563
£
. 163
& 54
0E0
4 ] 12 16 20
1m
0 . Line Profile, Power Spectrum,
Line Histogram: Blue - S
Line Histogram Panel 4----
Histogram 125
= 100
2 =
B -GG
el 3 50
i =] 25
0 5 50 75 100 125 0 . po—
- - 25 50 75 100 125
I nm
1 Statistics
! Une  Min(hm) Maxnim) Mid(nm) Mean(m) Rpvinm) Ra(om) Ra(m) Rzom) Rskipm) RKu(pm)
: MRed 10681 130740 70710 100481 120059 40360 34575 -59.393  -2378 5518 Lo
; Graen 0816 132612 71214 98084 122796 40978 3ssss -s2061 2064 4s03 | 4 = = — = Statistics Table
; ®Blue 2809 132444 67.627 99649 129635 41825 35413 63163 2422 5606
I
'
Histogram

Figure 4-1-1. Line view

4-1-1 Palette Panel, Image Display Panel and Histogram

Just as in other Analysis views, the image you want to analyze can be
displayed in the Image display panel with the Palette Panel. It is the same Palette
Panel and Image Display Panel that appears in all the analysis views of XEI. Please
refer to Chapter 3-2 and 3-3 for details. Also the histogram of the entire image
surface is displayed on the bottom of the Image Display Panel as in the other analysis

views. Please refer to Section 3-3 for details.
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4-1-2 Line Selection toolbar

Line selection toolbar, where the Tools for selecting line for the analysis are

gathered, is at the right side of the image Display Panel.

4-1-3 Line Profile, Power Spectrum and Line Histogram Panel

Line Profile, Power Spectrum, and Line Histogram is generated immediately
on the separate panel after you create a line across the image for line analysis.
These plots are automatically updated whenever you select the line and move the
selected line in the image. Detailed features of these three panels are explained in

section 4-3, 4 & 6 respectively.

4-1-4 Line Statistics Table

In the Line Statistics Table, the statistics table of the quantitative
measurements up to three selected lines (classified by different colors: red, green,
and blue) is displayed. The related values of the selected lines are changed in
accordance with the change in position of the cross section. Detailed features of the

Line Statistics Table are explained in section 4-5.

4-2. Selecting Lines for Line Analysis

To get reasonable information of line profile of the sample, it is important to
select specific lines for analysis. Line selection toolbar contains various tools that
help you to select precise lines for line data analysis. The process of selecting line

for analysis is done in three steps.

Step 1. Select Type of the Line N— | =1

You can create up to three lines for line profile analysis on the image (see
Figure 4-2-1): vertical, horizontal and/or arbitrarily sloped lines are possible. Each line
you create is indicated by a different color (red, green, and blue in order) in the Image

display panel as well as in the analysis plots. The Selected line will display end points
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of an arrow to easily identify the selected line.
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Figure 4-2-1. Line selection toolbar

Step 2. Create the Line N— | Ss1

B XorYaxisline —/ |

Click the X or Y axis line button on the line selection toolbar to generate a
horizontal or vertical line to be analyzed as a cross section of the sample surface.
Then, click the cursor at any location on the image where you would like to analyze
the height profile. The colored horizontal or vertical line will appear in the image.
You can easily move the line for analysis anywhere in the image by dragging and
dropping the line again and again. Figure 4-2-2 shows an example of moving a X

axis line for analyzing different image cross sections.
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Figure 4-2-2. Move a line for Line view

m Slanted line \

As shown in Figure 4-2-3, after clicking the slanted line button, press the

cursor onto any location where you would like to start the arbitrary slanted line. Drag

and drop the cursor onto the end point of this line. To change the location of the line,

follow the same procedure as for a vertical or horizontal line. Furthermore, you can

resize the line by clicking the line to display trackers at the two end points of the line.

Then, drag and drop these trackers.
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Figure 4-2-3. Create a slanted line

m Average line SEI

For each X, Y and Slanted lines, there are also Average lines. The process for
creating an Average line is the same as creating a single line. When an Average line is
created, it is colored from center line towards each side. The selected average area
will display in the Line Profile panel as a single Line Profile. Average Lines can be
resized by clicking the circular tracker and dragging to desired area. Figure 4-2-4

shows Average X axis Line.
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Step 3. Edit the created Line |~

You can move, delete, and resize the line created in step 2 with the help of
the ‘Move tool’. The Move tool will only appear on the toolbar if you have checked
the ‘Line’ check box in the ‘Use Move Tool’ option of the ‘Preferences Window’'.

/IIWhen the ‘Use Move Tool’ option for the ‘Line’ is checked, the mouse
pointer stays in ‘line selection’ (cross hair mouse pointer) mode so that user can
continuously create lines for analysis without reselecting the line button on the
toolbar for each line. The mouse pointer will stay in ‘line selection’ mode unless you
deselect the 'Move Tool’ button |™ | to exit ‘line selection’ (cross hair mouse pointer)
mode and switch to ‘line editing’ (arrow mouse pointer) mode.

e

On the other hand, when the ‘Use Move Tool’ option for the ‘Line’ is not
checked, the mouse pointer will automatically switch from ‘line selection’ (cross hair)

to ‘line editing’ (arrow) mode each time you create a line.

B Selecting

First, select the line corresponding to the line shape you would like to edit.
Next, click ‘Move tool’ to enable line editing. Click on the line you would like to move
to select it. You can also select multiple lines by pressing ‘Ctrl’ key as you click the

lines. To select all the lines, press Ctrl+A, or select ‘Select All’ in the context menu.

H Moving

To move an object, move the mouse cursor over the object until it becomes a
four-arrow cursor and the circular tracker appears (circle and arrow at endpoints) on

the line. You can move the selected line by dragging it.

B Deleting

To delete the selected line, right click to bring up the context menu and select

the delete command or press delete button on the keyboard.
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B Changing Shape

For slanted lines, you can resize the line by clicking the line to display circular
trackers (circle and arrow) at the two end points of the line. Then, drag and drop

these trackers.

B Measuring Angle between Lines A

As shown in Figure 4-2-5, when clicking the ‘Show Angle’ =</ icon, the angle
value between two lines will be displayed on Image Display panel. ‘Show Angle’ icon

can be selected under the line selection toolbar.
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Figure 4-2-5. Show angle between two lines

B Change Image Color(Use Enhanced Color)

For effective line analysis, enhanced color can be used in the Image Display

panel. Clicking the ‘Use Enhanced Color’ g icon, will activate the feature. Please
refer Section 3-2-5 for more detail.
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Figure 4-2-6. Use Enhanced Color

4-3. Line Profile Panel

The Line Profile panel displays the cross-sectional height profile of the image
along the line created by user. The unit of x axis is usually um or nm and that of y axis
is variable depending on the collected signal to generate its image for example, um,

nm, mV, V and so on.

B 1:1 Visual Ratio

Displays ratio between the X and Y’s line profile as 1:1 ratio. This feature

can be useful for enlarging the Y axis’ line profile.

B Move

Selecting this icon @ will allow to the user to scroll the viewable area by
clicking and dragging the image.

B Zoom Out

When selected, the line profile is automatically scaled in the Line Profile panel

by clicking icon.
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A context menu (see the outlined box in Figure 4-3-1) is generated when you

right-click the cursor in the Line Profile panel. The items of the context menus are
described below.
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Figure 4-3-1. Context menu in the line profile

4-3-1 Export

Through the ‘Export’ command in the context menu of Line view, you can
export the data of the Line Profile as a text file and save it individually. This text file
can be used for analysis in other software program.

4-3-2 Insert (Delete) a Cursor Pair

To measure an exact height difference and distance between two data points
in the Line profile, you can insert a cursor pair on the Line Profile by selecting ‘Insert a
Cursor Pair’ command in the context menu. You can insert up to three cursor pairs per
profile.

When the cursor pair is inserted, two triangular shaped cursors appear on two
arbitrary points on the Line profile and the corresponding points on the image in the
image display panel as well. Along with the cursor pair, ‘AX’, ‘AY’, ‘Angle’ information
is displayed in the Cursor Statistics table as default (Figure 4-3-2 and Figure 4-3-3).

Also, you can select the cursor pair parameters to be displayed on the table

from the ‘Show Items’ command in the context menu of the Cursor Statistics table as
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well. The cursor information parameters that can be displayed in the Cursor Statics
table are described below.

AX The horizontal distance between the two points marked by the cursors
AY The vertical distance between the two points marked by the cursors
Angle The angle between the points. This is determined by dividing the
vertical difference by the horizontal difference.

Left X The horizontal coordinate for the left cursor.

Left Y The vertical coordinate for the left cursor.

Right X The horizontal coordinate for the right cursor.

Right Y The vertical coordinate for the right cursor.

The context menu in the Cursor Statistics table is generated by right clicking
on the table. These menu functions are similar to those in region statics table except
for the items under the ‘Show Items’ command. Refer to Section 4-3.
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Figure 4-3-2. Cursor pair and displayed information

You can adjust the location of the cursors by dragging and dropping individual

triangular cursors either from the line profile or from the image in the image display
panel.

You can also move the cursors with pixel precision by clicking on a cursor,

then pressing the — and < keys on your keyboard. The displayed cursor
information is automatically updated whenever you change the position of the cursor

pair. Figure 4-3-3 shows an example of using the cursor pair.
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Figure 4-3-3. Moving cursors by mouse

To delete the cursor pair from the line profile, click the cursor pair which you
want to delete and select ‘Delete a cursor pair’ command from the context menu or

use the ‘Delete’ button on your keyboard. This command deletes the selected cursor

pair from the Line Profile. To delete all of the cursor pairs from the Line Profile, select
Delete all cursor pairs’ command from the context menu

4-3-3 Interpolation

This function allows smooth shifting between pixels by adding another point in
between two points. If this function is disabled, it will only move as pixels
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4-3-4 Leveling

After you select ‘Leveling’, you will see two white bars in the line profile. You
can use these bars to easily subtract the background slope. Point your mouse at each
bar and the cursor will change to a left-right arrow. Drag each bar to two different
points you believe to be at the same height. The slope of the line profile will change
accordingly so that the two different points are brought to the same level. After leveling,

the white bars can be disappeared by deselecting ‘Show leveling bars’.

4-3-5 Profile Range

Selecting ‘Profile Range’ will appear Profile Range dialog. Line profile range
can be adjusted in this dialog.

Profile Bange E|
Fed

) |sotropic
) Fixed Range
Mintnm)

Faxinmm)

[]5Sync all Lines

Done

Figure 4-3-4. Profile Range

B Color

Displays a selected line profile color

B Auto Range

When selected, automatically adjusts the range of the display so that the

whole line profile is visible on the graph.

B |[sotropic

Fits the Y scale to the maximum scale of X. Consequently, you will see a
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height that is similar to the real line profile.

B Fixed Range
The vertical scale indicates the height range of the line profile. By default,
maximum (minimum) value of the data range corresponds to the maximum
(minimum) data of a line profile. This data range can be edited by changing

the ‘Max (Min)’ text field in ‘Fixed Range’ of ‘Profile Range’ dialog.

B  Sync All Lines

When selected, the vertical data range scale of all the lines will be matched.

4-3-6 Copy to Clipboard

Through the ‘Copy to Clipboard’ command in the context menu of Line view,
you can copy the line profile data to clipboard as text or image file and paste [Ctrl+V]

button on the corresponding document file.

4-4. Power Spectrum Panel

When you select a line in an image, its power spectrum is displayed in the
Power Spectrum panel. Figure 4-4-1 shows the power spectrum of the selected line
in the Line view. A power spectrum shows the contribution of each spatial frequency
to the line profile versus frequency. It is generally used to examine spatial
periodicities in an image and to measure noise characteristics. When you select a

line in an image, a power spectrum is automatically displayed.

The Power Spectrum, shown below, is related to the 1-dimensional Fourier
transformation of the selected line in the Line Profile. In a Power Spectrum, peaks
represent the intensities of frequency components in the selected line. The x axis is
the frequency of the selected line and its unit is 1/um. The y axis is the intensity of
the frequency component and its unit can be Axpm, umxpm, Vxum and so on. The
front unit is varied by on the unit of the selected input signal and z scale within the
selected line and the next unit is varied by the length of the line.

A context menu is generated when you right-click the cursor in the Line Power
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Spectrum panel. Currently, ‘Export’, ‘Copy to Clipboard’ and ‘Show Pair Cursor Pair’

menu are available commands. For more information, refer to Section 4-3.
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Figure 4-4-1 Power spectrum panel

4-5. Line Statistics Table

The Line Statistics table, shown in Figure 4-5-1, shows several statistics of the
line profile. Each line is related to one row of the table. The results of the statistics
on the selected line are updated automatically when you move the selected line to
different locations in an image. The context menu (see the outlined box in Figure 4-
5-1) is generated when you right-click the cursor in the Line Profile panel. Through the
context menu, the statistics table can be rearranged as desired. These menu items

are described as Figure 4-5-1.

Statistics
Line Min(nm)  Max(nm) Mid{nm)  Mean{nm) Rpw(nm} Rgi{nm)  Ralnm)  Rz(nm) Rsk Rku
M Red -8.923 5931 -1.496 -0.004 14.854 3.271 2.383 Export ) |-992
! Green -3.042 6.136 1.547 1.758 9.178 1.642 1.319 2.981
Copy to Clipboard »
M Blue -3.596 3.911 0.158 0.215 7.507 1.863 1.559 2.081
Show ltemns »
Horizontal Unit ~ »
Vertical Unit 3
Scientific Notation
Figure 4-5-1. Line statistics table
B Export

Export the statistics data as image or text file.
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B Copy to Clipboard

Copy the statistics data as image or text file to clipboard and you can paste

the corresponding document file.

B Show ltems

Select the line profile parameters to be displayed on the statistics table.

B Horizontal Unit

In the Statistics table, sets the scale units of the horizontal axis. As default,
each parameter scale uses the ‘Auto Unit’ feature. The horizontal (X) axis for all
parameters can be manually set to the same single unit (fm, pm, nm, pm, mm, and

m).

B Vertical Unit

In the Statistics table, sets the scale units of the vertical axis. As default, each
parameter scale uses the ‘Auto Unit’ feature. The vertical (Y) axis for all parameters

can be manually set to the same single unit (fm, pm, nm, um, mm, and m).

B Scientific Notation

Line profile parameter values in the Statistics table will be displayed in
Scientific Notation (Exponential Notation). The values are displayed to three decimal
places. Due to limited space in the Statistics table, this feature is useful when

displaying multiple parameters.

The meanings of the surface profile parameters displayed in the Line

Statistics Table are defined as follows.
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Table 4-5-1. Line Profile Parameters

Parameter Name Meanings

Min Min is the minimum, or smallest, value in the line
profile.

Max Max is the maximum, or largest, value in the line
profile.

Mid Mid is the arithmetic average between the minimum
and maximum values. That is, Mid = (Max + Min) / 2.

Mean Mean is the arithmetic mean value of the line profile.
It is the sum of the height of each point divided by the
number of points.

Rpv Rpv is the peak-to-valley of the line. It is the
difference between minimum and maximum, that is,
(Max — Min).

Rqg Rq is the root-mean-squared roughness.

Ra Ra is the roughness average. The average roughness
is the area between the roughness profile and its
mean line.

Rz Rz is the ten point average roughness. It is the
arithmetic average of the five highest peaks and five
lowest valleys in the line.

Rsk Rsk is the skewness of the line.

Rku Rku is the kurtosis of the line. It indicates the

“spikiness” of the sample surface along that line.

4-6. Line Histogram Panel

The Line Histogram panel provides information about the distribution of heights of

the pixels within the selected line. Corresponding to the three selectable line groups,

up to three Line Histograms (R, G, B) can be generated. Figure 4-6-1 shows the Line

Histogram panel. The x axis represents the height of data points in the line. The y axis

represents the number of pixels in the selected line. Several features that helps user
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to perform further analysis of the Line Histogram can be accessed through the
context menu. You can see the context menu in the Line Histogram panel right the

mouse with the pointer on the table.
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Showe Cursor Pair

-20 0 20 40 60
nm

Figure 4-6-1. Line Histogram Panel
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Chapter 5. Region View

In the Region view, you can measure and analyze surface regions of an
image. You can make quantitative measurements of surface features in the selected
regions and collect surface statistics such as surface roughness, average height.
These statistical values are displayed in the table and plotted in the Region Histogram
panels. Up to three particular regions can be selected to include regions for analysis.

Furthermore, you can select regions to exclude certain features from analysis.
In general, you can go through the following steps in Region view:

1. Load an image you want to analyze into the Analysis view from the
Navigator view.

2. Enable the Region view.

3. Select regions of the image to include or exclude for Region view.

4. Once selecting region group, both the region histogram plot and statistics
table are generated with results and updated whenever the change of the
selected region group occurs.

5. Save and print your Region view results

Figure 5-1 shows the summarized procedure to analyze the region of an

image.
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5-1. Layout

To enable the Region view, select ‘Analysis>Region’ menu or click the Region
analysis tab below the Toolbar. The Region view consists of the Palette Panel, Image
Display Panel, Region Selection Toolbar, Region Histogram Panel, Histogram and the

Statistics table. Figure 5-1-1 shows the Region view that is divided into several parts.
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Figure 5-1-1. Region view

5-1-1 Palette Panel, Image Display Panel and Histogram

Just as in other Analysis views, the image you want to analyze can be
displayed in the Image display panel with the Palette Panel. It is the same Palette
Panel and Image Display Panel that appears in all the analysis views of XEI. Please
refer to Chapter 3-2 and 3-3 for details.

Also the histogram of the entire image surface is displayed on the bottom of
the Image Display Panel as in the other analysis views. However, Histogram in the
Region View has special ‘Height Restriction Markers’ to select pixels within certain
height range. Detailed features of the Region Selection Toolbar are explained in

section 5-2.
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5-1-2 Region Selection toolbar

Region selection toolbar, where the Tools for selecting region for the analysis

are gathered, is at the right side of the image Display Panel.

5-1-3 Region Histogram Panel

Three Region Histograms, corresponding to three different user-selected
Region groups (Red, Green and Blue), are generated automatically at the right side of
the Image display panel. Detailed features of the Region Histogram Panel are

explained in section 5-4.

5-1-4 Region Statistics Table

In the Region View, below the Image display panel, the Region Statistics table
will be generated. Detailed features of the Region Statistics Table are explained in

section 5-5.

5-2 Selecting Region for Region Analysis

To get reasonable information of surface statistics, it is important to select
specific regions including or excluding the data for analysis. Region selection
toolbar contains various tools that help you to select precise region for region data

analysis. The process of selecting region for analysis is done in four steps.

Step 1. Select Region Group HEE

Region Group is the group of the ‘selected area’ for the region statistical
analysis. Each region group is made of single or multiple ‘selected area’. XEI
allows user to create and edit up to three Region Groups, Red, Green and Blue for
region analysis. The ‘selected area’ that belong to different Region Groups are
discriminated by their color. Before you create or edit ‘selected area’ on the image
for the region analysis, you should decide to which region group the ‘selected area’

will belong by clicking one of the Region Group Select button.
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Figure 5-2-1. Region Group

Step 2. Select Inclusion or Exclusion (# 8

You should decide whether the pixels within the ‘selected area’ you create to
be included or excluded by clicking either Inclusion or Exclusion before you create a
‘selected area’. Figure 5-2-2 shows effect of selecting Inclusion and Exclusion on
region analysis result. Be aware that the selecting area as ‘Exclusion’ is effective
only if the area selected as ‘Exclusion’ is part of the area that has been selected as

‘Inclusion’.
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Pixels within red rectangle is included in the
region analysis. Notice the two separate
distribution (a and b) in the histogram owing to
the two different features (A and B) in the
selected region with different height.
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the region analysis. Notice the change in the
= 5 distribution of the pixels as the pixels of the
feature A that had low height are excluded from
- - the analysis.

Figure 5-2-2. Region view

Step 3. Create ‘selected area’ U © > K

You can create ‘selected area’ of different shapes by using Rectangle, Ellipse
and Polygon button. Also you can designate entire image as a ‘selected area’.
‘Selected area’ for Inclusion will be painted in red, green, and blue while the ‘Selected
area’ for Exclusion will be only outlined in red, green and blue depending on the color

of the region group to which selected area’ belongs to.

B Rectangle & Ellipse D ©

To create rectangle or ellipse shaped ‘selected area’, click the ‘Rectangle’ or
‘Ellipse’ button, respectively. Then, press the cursor at the point you want to create
the top-left corner of a ‘selected area’, and drag the mouse pointer at the point you

want to create bottom-right corner of a ‘selected area’.

® Polygon &

To create polygon shaped ‘selected area’, click the polygon button and click
the cursor onto the point you want to create a starting point of a polygon. Move and
click the cursor at each point of the polygon region. Double-click at the point you

would like to make the end point.

B Entire Region *

To set the entire image as ‘selected area’, click the ‘Entire Region’ button. It is

set as default when you select ‘Region View'.
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Step 4. Edit the ‘selected area’ |~

You can move, delete and resize the ‘selected area’ created in step 3 with the
help of the ‘Move tool’. Move tool only appears on the toolbar only if you have
checked ‘region’ check box from the ‘Use Move Tool’ option in the ‘Preferences
Window'.

When the ‘Use Move Tool’ option for the ‘region’ is checked, mouse pointer
stays in ‘region selection’ (cross hair mouse pointer) mode so that user can
continuously create ‘selected area’ for region analysis one after another. Mouse
pointer will stay in ‘region selection’ mode unless you click 'Move Tool’ button |~ | to
exit ‘region selection’ (cross hair mouse pointer) mode and switch to ‘region edition’
(arrow mouse pointer) mode. On the other hand, when the ‘Use Move Tool’ option
for the ‘Region’ is not checked, the mouse pointer will automatically switch from
‘region selection’ (cross hair) to ‘region edition’ (arrow) mode each time you create a

line.

B Selecting

First, select the region group (R, G, B) corresponding to the region shape you
would like to edit. Next, click ‘Move tool’ to enable the region shape edit. Click on
the region shape you would like to move to select it. You can also select multiple
region shape by pressing ‘Ctrl’ key as you click multiple region shape. To select all
the region shape of the region group, press Ctrl+A or select ‘Select All’ in the context

menu.

H Moving

The mouse cursor changes to four arrow cursor and selected region shape is

marked by circular tracker around it. You can move the selected region by dragging it.

B Deleting
To delete the selected region shape, select delete command from the context
menu or press delete button.
B Changing Shape

In case of rectangle and ellipse, you can also extend or shrink the selected

region by dragging a small circular tracker that appears when you click the region.
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You can also rotate a rectangle and ellipse by dragging a green circular tracker. In
case of polygon, you can change the shape of the already made polygonal region by
dragging each circular tracker of it. However, the number of points cannot be

changed.

5-3. Height Restriction Markers

Below the Image display panel, histogram of the loaded image is displayed.
Height restriction markers are two flags that appear when the Region Histogram is
displayed. Height Restriction Markers are used to exclude the pixels within certain
height range from the region analysis.

There are two Height Restriction Markers, Lower and Upper. Drag these two
‘Height restriction Markers’ on the each side of the histogram to set the lower and
upper value of the pixels to be selected. Pixels with the height lower than the ‘Lower
Height restriction Marker’ or higher than the ‘Upper Height restriction Marker’ will be
excluded from the region analysis. Pixels that are excluded from the analysis are

marked in violet color at Palette bar.
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| Notice that the histogram starts at 200nm
as pixels with height lower than 200nm
are excluded from the reaion analvsis.

’ Height Restriction Marker is set to exclude
pixels with the height below 200nm.

Trsg i *a, b, c: Pixels that has been excluded from the

z 3 H r region analysis via ‘Height Restriction Marker’ are
} lr “ displayed in purple color at Palette bar, Histogram,
S m and Image display, respectively.

100 ':o'ol 300 > l
nm

Lower Upper

Figure 5-3-1. Region view
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5-4. Region Histogram Panel

The Region Histogram panel provides information about the distribution of
heights of the pixels within the selected region. Corresponding to the three
selectable region groups, up to three Region Histograms (R, G, B) can be generated.

Figure 5-4-1 shows the Region Histogram panel. The x axis represents the
height of data points in the sample. The y axis represents the number of pixels (or
bearing ratio) in the selected region group. Several features that helps user to
perform further analysis of the Region Histogram can be accessed through the context

menu.
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Figure 5-4-1. Region histogram panel
5-4-1 Export

Through the ‘Export’ command in the context menu of Line view, you can

export the data of the Region Histogram as a text file or an image file and save it
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individually. This file can be used for analysis in other software program.

5-4-2 Bearing Ratio

Bearing ratio at arbitrary representative value in histogram is defined as

follows.

Bearing ratio
= 100% - percentage of the pixels whose values are below the current

representative value.

In default display, the y axis of the Region Histogram panel represents the number of
pixels in the selected region group. User can choose to display ‘Bearing Ratio’
instead of the number of pixels by selecting ‘Bearing Ratio’ command in the context

menu.

Region Histogram: Blue
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Bearing Ratio: Blue

80
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Figure 5-4-2. Bearing Ratio display
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5-4-3 Insert (Delete) a Cursor Pair

Cursor pair can be inserted into a Region Histogram as it can be done in the
Line Profile Panel (See section 4-3-2) to measure a difference between the number of
pixels (or bearing ratio) and the representative value of two columns in the histogram.
You can insert a cursor pair on the Line Profile by selecting ‘Insert a Cursor Pair’
command in the context menu. You can insert up to three cursor pairs per profile.
Figure 5-4-3 shows a cursor pair inserted in the Region Histogram.

When the cursor pair is inserted, two triangular shaped cursors appear on two
arbitrary columns on the Region Histogram. Along with the cursor pair, additional

information is displayed (Figure 5-4-3).

Region Histogram: Green
\ Difference of the
number of pixels

_ = Difference of the
= ~ i
o S representative values
Ty B |
100 [81.989 | 150 200 250 300
nm
Bearing Ratio: Blue Difference of the
bearing ratio .
9 Difference of the
80 representative values
60
R

40
20

nm

Figure 5-4-3. Cursor pair and displayed information

You can adjust the location of the cursors by dragging and dropping individual
triangular cursors either from Region Histogram. The information displayed with the
cursor are automatically updated whenever you change the position of the cursor pair.

To delete the cursor pair from the Region Histogram, select ‘Delete a cursor
pair’ command from the context menu. This command deletes selected cursor pair
from the Region Histogram. To delete all the cursor pair from the Region Histogram,

select ‘Delete all cursor pairs’ command from the context menu.
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5-5. Region Statistics Table

The Region Statistics table, shown in Figure 5-5-1, displays the statistics of
the all data points in the selected region group. Each region group is related to one
row of the table. The results of the statistics on the selected region are updated
automatically when you change the selected region group by resizing or moving the
region selector.

The context menu (see the outlined box in Figure 5-5-1) is generated when
you right-click the cursor in the Region Statics table. The menu items are same as one

in Line Profile Statics table. Refer to Section 4-5.

Statistics
Region Min{nm) Max(nm)  Mid{nm) Mean{nm)  Rpv(nm) Rag{nm) Ra(nm) Export » Rku
M Red -163.853  119.981 -21.936 -85.128 283.834 101.547 6. 7 2,585
M Green -367.722 94892  -136.415  -299.732 462614 86.431 p14 CoeytoClipboard g, . .0,
¥ Blue 525.057  107.717  -208.670 -252.490 632.774 225.794 207.4f Show ltems ris 1.540
R-G 203.870 25.089 114.480 214.604  -178.780 15.116 24. Horizontal Unit ~ »[6  -5.176
RB 361.205 12.264 186.735 167.363  -348.940  -124.247  -121.1]  Vertical Unit » 2 1.046
GB 157.335 -12.825 72.255 -47.241 170160  -139.363  -145. Scientific Notation |8 6.222

Figure 5-5-1. Line statistics table

The meanings of the surface profile parameters displayed in the Region

Statistics Table are defined as follows:

B Min

Min is the minimum height value of the region.

B Max

Max is the maximum height value of the region.

® Mid
Mid is the arithmetic average between the minimum and maximum height

value within the selected region. That is Mid = (Min + Max) / 2.

B Mean

Mean is the arithmetic mean height value of the region. It is the sum of the
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height of each point divided by the number of points in the selected region.

H Rpv

Rpv is the peak-to-valley of the selected region. It is the difference between

minimum and maximum, that is, (Max — Min).

E Rq

Rq is the root-mean-squared roughness. It is the standard deviation of the

height value in the selected region.

H Ra

Ra is the average roughness. The average roughness is the area between the

roughness and its mean.

H Rz

Rz is the ten point average roughness. It is the arithmetic average of the five

highest peaks and five lowest valleys in the selected region.

B Rsk

Rsk is the skewness of the selected region.

B Rku

Rku is the kurtosis of the selected region. It indicates the “spikiness” of the

selected sample surface.
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Chapter 6. Grain View

In the ‘Grain View’ user can perform grain analysis on the loaded image.

System automatically

1. Detects grains in the image

2. Marks each detected grain with different colors and numbers

3. Calculates important surface profile parameters of each detected grain
and displays them in table,

4. Displays Distribution of surface parameters among detected grains will

be displayed in the histograms.

Basically, you can perform grain analysis on the loaded image through the

following procedure.

1. Bring an image file into the Analysis view from the Navigator view.

2. Enable the Grain View and select between two grain detection
methods, Threshold or Watershed.

3. Set appropriate parameters for the selected grain detection method
(Threshold: Range, Watershed: Filter level). Run the automatic grain
detection process.

4. Each detected grain will be marked with different colors and numbers
on the loaded image. Surface profile parameter of each detected
grain will be displayed in the table. Distribution of surface
parameters among detected grains will be displayed in the histograms.

Export table, image and histogram as image or text file if desired.
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6-1. Grain Detection Method

User can select between two different grain detection methods to use for
automatic grain detection process. These two detection methods are ‘Threshold’
and ‘Watershed’.

6-1-1 Threshold method
B Algorithm

In the algorithm of ‘Threshold’ grain detection method, group of pixels
surrounded by the other pixels whose values are larger (or smaller) than the upper (or
lower) ‘Threshold’ value are recognized as grain. Figure 6-1-1 shows a simplified 1D

example showing how ‘Threshold grain detection algorithm” works.

Range: Upper Range: Lower

VAP NASS VAW

: Detected Grain : Detected Grain

Figure 6-1-1. Threshold Grain detection

As can be seen from Figure 6-1-1, grain detection result differs according to the range
setting and threshold value setting. XEI allows users to select between ‘lower’ and
‘upper’ for range and set the value of threshold by moving ‘Height restriction marker’ in
the histogram of loaded image. The area of ‘Height restriction marker’ can be reset by
clicking ‘Reset Bounds’ on Histogram Context menu (right clicking histogram will pop-

up).

B Upper

When the range is set to ‘Upper’, the ‘Height restriction marker’ appears on

the left side of the histogram. User can set the ‘upper threshold value’ by moving the
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‘height restriction marker’. The pixels corresponding to the left side of the upper
threshold markers are colored in purple to indicate their values are smaller than the
threshold value selected by the marker. Group of pixels surrounded by the other
pixels whose values are smaller than the ‘Threshold’ value (i.e. pixels that are not

colored in purple) are recognized as grain.
m Lower

When the range is set to ‘Lower’, the ‘Height restriction marker’ appears on
the right side of the histogram. User can set the ‘lower threshold value’ by moving
the ‘height restriction marker’. The pixels corresponding to the right side of the lower
threshold markers are colored in purple to indicate their values are larger than the
threshold value selected by the marker. Group of pixels surrounded by the other
pixels whose values are larger than the ‘Threshold’ value (i.e. pixels that are not
colored in purple) are recognized as grain. Figure 6-1-2 shows the example of

‘Threshold’ grain detection process.
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Figure 6-1-2. Threshold Grain Detection Process

6-1-2 Watershed method
B Algorithm

To understand the algorithm of ‘Watershed’ grain detection method, let’s look
at the 1D example in the Figure 6-1-3.
Now, let’s imagine that we pour water over this surface. Water will first fill the

lowest point of the surface. The region that water starts to fill in is recognized as

99



XEI Software Manual

a single grain. As the level of water increases, water starts to fill more region of
the surface and thus more grains are detected. Then when the level of water
reaches certain value, water filing one grain will start to overflow to other

neighboring grains. Algorithm recognizes this point and sets the grain boundary.

g

level 2

Water
level 1

Grain boundary is determined as a
point where water spills out from

( one grain to neighboring grain.
Water

level 3

level 2

——cnin' 7%}/ Grein2  Grain 3

Figure 6-1-3. Watershed Grain Detection Process

B Parameter settings in ‘Watershed’ grain detection

As it can be expected from the algorithm of the ‘Watershed’ grain detection
method, surface roughness affects the number of detected grains, or the ‘sensitivity’ in
the watershed grain detection method. See Figure 6-1-4. In some cases, ripples in
the images can be detected as a grain via watershed algorithm, resulting in a single

grain to be divided in to many ‘unwanted’ grains.
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Grain View

Figure 6-1-4. Effect of filtering on ‘Watershed’ grain detection
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To control the surface roughness and thus the detection sensitivity of the method, it is

desirable to apply ‘smoothing’ filter to the image before the detection algorithm starts.

‘Filter level’ parameter is the level of filter that is applied to the image before the

‘Watershed’ grain detection starts.

be smoothed before grain detection to remove ‘grains’ created by noise.

The higher the filter level, the more the image will

Filter level

acts to control the sensitivity of the grain detection as shown in Figure 6-1-5. Notice

the difference in the number of total detected grain displayed in right corner and how

the grains circled in dotted line differ according to the filter level.
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Figure 6-1-5. Effect of filter level on grain detection. Grain detection results with

Filter level 4 (left) and filter level 2.5 (right).
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6-2. Grain Display Panel

When the grain detection process is complete, XEI will mark each detected
grain with a different color and number. The number for each grain is allocated in the
order that it was detected. The color of each grain is randomly generated from XEI in
order to prevent any grains being marked with same color. (Each colored grain is best

seen if you view the original image in ‘Gray scale’.)

6-2-1 Selecting and deleting the detected grains

Each detected grain can be selected and deleted. This function is useful for
picking out the ‘unwanted’ grains. Just click on any detected grain to select it. Then
the boundaries of selected grains will be dotted with white circles. To delete the
selected grains press ‘Delete’ button. You can also select multiple grains. There are

two ways.

1. Hold down ‘CtrI’ button of your keyboard as you click multiple grains.

2. Click and drag to select grains in the region of your interest (Figure 6-2-1).
To select all the detected grains in the loaded image, click any where on the image

and then press ‘Ctrl+A’ or select ‘Select All' from the context menu which appears

when you right click on the image (Figure 6-2-1).

nm DVDiff nm DVD.iff

hel
1he W' FPe W

Figure 6-2-1. Multiple grain selection
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6-2-2. Show Number and Restore Grain Button

W Restore Grain Button <

Click this button to restore the deleted grains by reloading the initially detected

grains.

123

B Show Number Button

Click this button to display or hide the numbered label on each detected

grains.

DVD tiff

Show All Show Valley

Figure 6-2-2. Show All and Show Valley

B Show All (only in watershed mode) '™

Clicking this button displays all the grains detected by ‘watershed’ grain
detection method.

® Show Hills Only (only in watershed mode) '*

Clicking this button displays only the ‘hills’ among the grains detected by
‘watershed’ grain detection method. In the algorithm of the ‘watershed’ grain
detection, hills are defined as a grain whose average value of the pixels within

exceeds the average of the pixels on the boundary.

B Show Valleys Only (only in watershed mode) ¥

Clicking this button displays only the ‘valleys’ among the grains detected by

‘watershed’ grain detection method. In the algorithm of the ‘watershed’ grain detection,
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valleys are defined as a grain whose average value of the pixels within does not

exceed the average of the pixels on the boundary.

6-3. Statistics Table

After automatic grain detection, XEI calculates important surface profile
parameters of each detected grain. These parameters are displayed in the statistic

table. The meanings of the parameters are given in the table below.

Area Area is the projected area of the detected grain.

Volume Volume is the volume of the detected grain.

Length is the distance between the two farthest points within the

Length _ _
projected area of the grain.
Peri Peri is the perimeter of the projected area.
R Rpv is the peak-to-valley of the line. It is the difference between
pv

minimum and maximum, that is, (Max-Min).

Table 6-3-1. Grain statistics parameters

In the ‘Statistic Table’, the surface profile parameters of the detected grains
are arranged in numerical order. If more than 20 grains are detected system will
display 20 grains at each page. You can jump from pages to pages through the
arrow at the bottom right of the table. When the user selects grains from the image,
surface profile parameters of the selected grains are displayed in the top of the table
in bold letter. Moreover, when multiple grains are selected, mean value and standard
deviation of each parameter are displayed in Mean and Std row. Table can be
exported as a table or text file from the context menu which is shown when you right
click the mouse with the pointer on the table. Currently, the context menu has ‘Export’,
‘Copy to Clipboard’, ‘Show Items’, ‘Horizontal Unit’, ‘Vertical Unit' and ‘Scientific

Notation’ items. For the information, please refer to the Section 4-5.
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Statistics
Grain Area(ums2) Yol{ums) Length(um) Peri{um) Rpwinm)
Mean 1.684E-1 6.132E-3 0.633 1.880 49779
Std. 1.049E-1 4. 0BE-3 0.290 0.801 2.856
1 0.205 0.008 0.755 2.049 59117
2 0.035 0.001 0.332 0.908 57.629
3 0112 0.004 0.434 1.461 54 556
4 0.497 0.019 1.622 4.664 49422
5 0.208 0.008 0.713 2.091 49709
] 0.028 0.001 0.312 0.818 51.411
7 0139 0.005 e A 47.500
8 0.145 0.005 Export a 49,659
9 0.267 0.010 Copy to Clipboard » §1.053
10 0.106 0.003 Shaw ltems » 47.811
a1 0113 0.004 Horizontal Unit > 49155
12 0.066 0.002 Vertical Unit » 46.588
13 0.268 0.010 Scientific Notation 49.084
14 0107 0.004 0.438 1.423 43.604
15 0.159 0.006 0.565 1.842 47.764
16 0.106 0.004 0.429 1.366 48.293
17 0.164 0.006 0.583 1.927 48.004
18 0.099 0.003 0.407 1.373 47.260
19 0.214 0.008 0.735 2181 51.532
20 0.440 0.017 1.355 3773 48.987
Count: 20430 &= Page: 1/2 =

Figure 6-3-1. Statistics Table

6-4. Histogram Panel

The distribution of the certain surface profile parameters related to the grain
size analysis, (i.e. area, volume, surface, perimeter) is plotted as a histogram in the

histogram panel.
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Figure 6-4-1. Statistics Table
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Chapter 7. PSD View

In the ‘PSD View’ user can view PSD graph of the loaded image and obtain

relevant data. PSD view is useful for surface roughness analysis.
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Figure 7-1. PSD View

7-1. What is PSD?

PSD is an abbreviation of “Power Spectrum Density.” PSD of the loaded
image is obtained from Fourier Transform (FT) of the image and reflects the RMS
roughness of the sample surface. PSD, FT, and RMS roughness are related as

follows.

PSD = FT? = RMS?
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The power spectral density (PSD) of a surface is equal to square of its Fourier

Transform (FT) and RMS roughness value squared.

7-1-1 Meaning of PSD

PSD is one of many parameters that are used to represent the surface
roughness of the sample. PSD has advantages over the other surface roughness
parameters such as RMS roughness because PSD contains the information how
each frequency components contributes to the total roughness of the surface.

The example below shows the advantage of PSD as a surface roughness
parameter. The images ‘sinepi.tiff and ‘sine2pi.tiff’ in Figure 7-1-la are synthetic
images generated from two sine functions with same amplitude but different

frequency.

10

7.5

25 5 75 10

5 25 5 75 10
Hm

um

sinepi.tiff sine2pi.tiff

Roughness parameters of ‘sinepi.tiff’

Statistics

Region Min{pm)  Max{nm) Mid{nm) Mean{nm) Rpvinm) Rag{hm) Rainm) Rz{pm) Rskipm) Rku{pm)
¥ Red 0.000 447.391 223.695 223.709 447.391 157978 141.909 -26.673 -0.001 205.645

Roughness parameters of ‘sine2pi.tiff’

Statistics

Region Min{pm)  Max{nm) Mid(nm)  Mean{nm) Rpvinm) Rg{hm) Ra(nhm) Rz{pm) Rskipm) Rkuipm)
¥ Green 0.000 447.391 223.695 223.709 447391 157.978 141909 -26.673 -0.001 205.645

Figure 7-1-1a. Two synthetic images of same roughness
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As a result, their roughness parameters (Rpv, Rq, Ra, Rz, Rsk, Rku) are same
despite eminent differences between their surface profile. These images are also
included in sample image folder of XEI (C:\Park Systems\XEI\Samples). You can

verify that they have the same roughness.
However, PSD graph which contains not only roughness information but also
the contribution of each frequency components to the roughness can discriminate the

difference of roughness between two images.

2D PSD of ‘sinepi.tiff’
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Figure 7-1-1b. PSD of two synthetic images of same roughness

7-2. PSD Graphs

XEI calculates and plots three different types of PSD for the loaded image;
PSD X, PSD Y and PSD 2D. The X axis of the PSD X and PSD Y graph is the
‘spatial frequency (cycle/um)’ of the image. For PSD 2D graph, the unit of the
‘spatial frequency’ is different (cycle/um®) as the range of power spectrum is 2
dimensional area.

The Y axis of the PSD graph is ‘Power Spectrum Density’, which is Power
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spectrum (pmz) corresponding to each spatial spectrum (cycle/um) value. Thus the
unit for the Power Spectrum Density is um?/ (cycle/um) = um?.
For each PSD graphs, there are two cursor(F1, F2) that slides along the X

axis to mark point of interest on the PSD graph.

7-2-1 PSD 2D

PSD 2D graph is generated from 2 dimensional Power spectrum of the image.
Power corresponding to the area of same ‘spatial frequency’ (represented as

concentric circle in 2D power spectrum of the image)

PSD: 2D

2.5E-5 4
2E-5 1

E 15E-5¢1
1E-51

5E-6 |

oe0 L\

+
v

1um

Figure 7-2-1a. PSD 2D

7-2-2 PSD X(Y)
PSD X(Y) is an average of the power spectrums for each line of the image

parallel to X(Y) axis

PSD: X Axis
4E-4 i ! !
3E-4 :
Y- >
E 2Ea
1E-4
0ED A
0 5 10 15 20 25
1ium

Figure 7-2-1b. PSD X axis
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PSD: Y Axis

5E-4 = ! —
4E-4
3E-4
2E-4
1E-4

0EOD 4
1] 5 10 15 20 25
1/um

pm?

Figure 7-2-1c. PSD Y axis

7-2-3 PSD Context Menu

Right clicking on the graph will appear menu window as Figure 7-2-2d.

PsD: 2D
- ~ Export 4
3E-28 1 fl Copy to Clipboard »
E 26281 ”’l. v Show Cursor Pair
1E-28--/ K\A Axis Options
4

E6 BE6 1.2E7 1.6E7 2ET
1im

Figure 7-2-2d. PSD Context Menu

B Export
PSD graphs can be exported to ‘text’ or ‘image’ file for further analysis through

other data processing software.

B Copy to Clipboard
PSD graphs can be copied to clipboard and pasted to the corresponding

document program.

B  Show Cursor Pair
For each PSD graphs, you can show two cursors that slide along the X axis

to mark point of interest on the PSD graph.
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PSD: 2D
1.6E-31 (’ \'
1.26-31 ~|
E BE-32
4E-32
2E7 4E7 6E7

1im

Figure 7-2-2e. PSD Show Cursor Pair

B Axis Options
Graph scale and range can be adjusted in ‘Axis Options’ dialog which is

popped up when choosing ‘Axis Options’ menu. Data Range/Scale can be appointed

on each axis.

Linear Scale: Display selected axis’ data range as linear scale.

Log Scale: Display selected axis’ data range as log scale.

Auto Range: Display full data range in a selected axis.

Fixed Range: Display selected axis’ inserted Min/Max values. To select big or

small value, base and exponent are separated.
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Axis Options
#Ais

(#) Linear Scale
() Log Scale
() Auta Range

x]

{(*) Fixed Range Base Exponent

Min || E2JE | 52
Max E.45 % JIE 78
Y Axis
() Linear Scale
(*) Log Scale

() Auto Range

Min | 13532 [ -372
o [l REE

Figure 7-2-2f. PSD Axis Options

7-3 PSD Statistics Histogram

Various statistical analysis results of the PSD graph is displayed in this
Histogram Panel. Below the Histogram panel, PSD Statistics table is shown at the
same time. When you right click the mouse with the pointer on the table, you can see
the context menu. Currently, the context menu has ‘Export’, ‘Copy to Clipboard’, ‘Show
Iltems’, ‘Horizontal Unit’, ‘Vertical Unit' and ‘Scientific Notation’ items. For the
information, please refer to the Section 4-5.
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PSD: 2D P12
5E-8 ™~
4E-8 \
PSD1 4 -EE
= 2E-8
PSD2 e s
0E0 1 —
0, 1 5 10 15 20 25
| | 1um
| I
4 4
F1 F2
Statistics
PSD F1{(1/mm) F2(1/um) PSD1(um?* ) PSD2(um*) P12inmd Rg12{nm) P{nhm? Rg{nm)
N 2D 600.000 8.800 4114E-6 1.86E-8 311.735 17.656 324.753 18.021

PSD F1{(1/um) F2(ljum) PSD1{um® PSD2(nm™ P12(nmd Rg12{nm) P{nhmd Rg{nm)
X Axis 0.800 12.200 1.049E-5 2.619E2 183.196 13.535 197.497 14.053
MY Axis 1.000 14.000 1.028E-5 2.339E2 184.046 13.566 239.594 15479

Figure 7-3-1. PSD Statistics & Histogram

m F1(2)

Spatial frequency of the cursor 1(2)’s position.
B PSD1(2)

Power Spectrum Density at the cursor 1(2)’s position.
m P12

Area under the graph bounded by the cursor 1 and 2.
H Rql2

RMS roughness between the cursor 1 and 2. Square root of the P12.

Total area under the graph.
B Rq

Total RMS roughness of the image. Square root of the P.
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Chapter 8. Fractal View

In fractal geometry, objects can have non-integer (fractional) dimensions.
Fractal analysis allows calculation of the dimension of sample topographies using the

triangulation, cube counting, and partitioning methods.

To see how an object can have a non-integer dimension, consider a
continental coastline. If one measures the coastline with a 100km-length ruler, a
certain measurement will result. Then, if one took multiple 10km-length rulers, a
larger measurement will result, as more of the curves will be counted. As the length
of the rulers used approaches 0, the measured coastline length approaches infinity.
The slope of this length-of-ruler to length-of-coast curve can be said to be the
dimension of the coastline. For a topographic image, one counts area or volume

instead of length.

As shown in Figure 8-1, the Fractal Analysis View consists of Image Display
Panel, the Fractal Analysis Control Panel, and the Fractal Graph.

The following procedure can be used for estimating D:

Bring an image file into the Analysis view from the Navigator view.
Select Fractal View.
Adjust the parameters in the Fractal Control Panel.

Adjust the cursors in the Fractal Graph.

o M w0 NP

Click the Recalculate button.

Figure 8-1 shows some of these steps.
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Figure 8-1. Procedure for Fractal view

8-1. Fractal View

To open the Fractal view, select the ‘Analysis>Fractal’ menu or click the
Fractal view tab below the Menu bar.

The Fractal view consists of three main regions (see Figure 8-1-1): On the left
is the Image Display Panel, which shows the image being analyzed. In the center is
the Fractal Control Panel, which accepts parameters from the user and displays the
analysis results. On the right is the Fractal Graph, which displays the curve relevant
to the selected analysis method, and allows the user to select the region to be used in

fractal analysis.
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Figure 8-1-1. Layout of Fractal View

8-2. Fractal Control Panel

There are several items in the control panel that can be controlled for

estimating D, the fractal dimension value, and for displaying the results of the

estimation.

8-2-1. Interpolation Type

When computing the fractal dimension, it is useful to increase the effective

resolution by estimating, or interpolating, values in between pixels.

linear interpolation is available.

Currently, only

Linear interpolation simply takes the arithmetic mean of the two pixels.

8-2-2. Method

There are several methods by which to calculate D.
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B Triangulation

In the Triangulation method, the surface of the image is “coated” with
triangular plates. As the triangles become more numerous and smaller, their
collective surface area increases. This relationship is the basis of the triangulation

method.

B Box Counting

In the Box Counting method, the image is imagined to be enclosed in a cubic
area. As the cube is increasingly split into smaller pieces, some of the resulting
cubes are no longer required to completely overlap the sample, and thus the

collective volume of the cubes decreases as their size decreases.

B Partitioning

Similar to the Box Counting method, the image is separated into prisms.
However, the value measured is not the combined volume of these prisms, but rather
the difference in height between the prism and the sample surface. As these prisms
become smaller, the sum of these differences, or variance, can be expected to
decrease. When the slope between the number of cubes and the variance is 3, the

fractal dimension is equal to 3 — /2.

8-2-3. Fractional Dimension

This label displays the estimated value for D with the current parameters.

8-2-4. Control Buttons

The Recompute button causes a new estimation to be performed with the
current settings.

The Reset button reverts all of the parameters to the default values.
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8-3. Fractal Graph Panel

The Graph Panel plots the number of subdivisions to the relevant value,
depending on the method described in 8-2-2. Two cursors are used to select the
domain to be used in estimating the fractal dimension. Simply click and drag the
cursors to move them, or select one and use the right and left keys to move them with

pixel precision.
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Chapter 9. 3D View

In the 3D view, you can see both the features of the image and the
relationships between those features in a 3D rendered view. Different from other
microscopic techniques such as SEM or TEM, the 3D view is unique to SPM. The
scanning probe microscope scans the sample surface horizontally (x, y) line by line
while collecting the vertical (z) direction profile of the sample surface. As a result, the
scanning probe microscope collects truly 3-dimensional (X, y, z) information from the
surface and this 3-dimensional data represents true surface topography.

Basically, you can create the 3-diemnsional perspective of an image through

the following procedure.

1. Bring an image file into the Analysis view from the Navigator view.
2. Enable the 3D view to generate an initial 3D rendering of the image.
3. Adjust several 3D rendering parameters to obtain the best 3D view

4. Export and print out the 3D image if desired.

Figure 9-1 shows the summarized procedure for 3D rendering of an image.
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9-1. 3D View

To open the 3D view, select the ‘Analysis>3D’ menu or click the 3D view tab

below the Menu bar.

The 3D view consists of two main regions (see Figure 9-1-1):
Image display panel that is placed to the left side in the Analysis view. The other is
the 3D rendering parameters panel to the right side.
described in detail in the next section.

In the 3D view, you can change the following characteristics of the image:

e The presented resolution of the image
e The rotation angle of the image

e The size of the image

e The height magnification

Resolution

Sampling: 2 v
Transform
X iz
Rotation: 43 253 85
Scale: 18 18 0733 2
Translation: 0
[[]1sotropic Z Scale
Light
X i T
Position: 18 18 28
~
Lumninosity. Y
off Low High
Reflexibility. J
off Low High

Enable Ambient Light
Option
Enable Perspective [] Show Wire Frame

Show XY Axis Show Z Axis
Fill Border [[] Show Plane
Restore Defaults

MouseSperm tift Pho.. rystal ift

Figure 9-1. Procedure for 3D view

e The position of the simulated light source

One is the 3D

These are going to be
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e The color and intensity of the simulated light source

e The color of the image and background

Information | Line | Region | Grain | PSD| 3D | Multi

3DImage — — — - 3D Rendering — — —=p| .
Display Panel + Parameter Panel sampling: [2 v
Transform
X Z
um Rotation: | -41 258 83
Scale 18 18 0733 3
25+
Translation: oS
[ Isotropic Z Scale
Light
X Y: iz
Position: 18 18 2
15 -
B Luminosity: Yo
off Low High
4 Reflexibility: Y
off  Low High
o Enable Ambient Light
Option
Enable Perspective [_] Show Wire Frame
0 Show XY Axis Show Z Axis
Fill Border [] Show Plane
Restore Defaults

Figure 9-1-1. Layout of 3D View

9-2. 3D Image Display Panel

In the 3D Image display panel, the 3-dimensional perspective of an image is
displayed and updated immediately after you adjust anything of the available 3D
rendering parameters. The 3D image is held within a frame and presented on a
virtual plane. Dragging the cursor within the frame allows you to rotate the image in

the 3D Image display panel.

Using the 3-dimensional (X, y, z) data set, the individual lines will be stacked to
generate the 3-dimensional perspective and then this view may be adjusted by
simulating the reflection of light from the surface. Surface features that would be
illuminated from above appear bright, and features that would be illuminated from an
oblique view appear dark. You can vary the direction of illumination by changing the
position of an artificial light source. You can also rotate the image to vary your

viewing angle. Figure 9-2-1 shows the general 3D Image display panel
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Figure 9-2-1. 3D Image display panel

9-3. 3D Rendering Parameters

The 3D rendering parameters can be adjusted to get the best 3-dimmensional
view of the sample surface. Whenever you adjust these parameters, they are
automatically applied to the 3-dimensional image in the 3D Image display panel.
These 3D rendering parameters, as shown in Figure 9-3-1, are described further

below.
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Resolution
sampling: |1 »
Transform
e N Z
Rotation: 04 04 0
Scale: 1.656 2
Translation: 0z 0 il
[ 1lsatropic =%Z Scale
Light
- ! £
Fosition: - 1% 2%
Lurninosity: J
Off  Lowe High
Reflexibility: J
Off  Low High
Enable Ambient Light
Option

Enable Perspective  [] Show Wire Frame
Show XY Auis Show 7 Axis
Fill Barder [ ]Use Enhanced Calar

Drag image to =

Restore Defaults

Figure 9-3-1. 3D rendering parameters

9-3-1. Resolution

Allows you to vary the resolution of the displayed 3D image. You can select

the number of sampling data points in the Sampling combo box. By default, the
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image pixel size is set to be 256x256. So the number of sampling data points is
automatically changed to be displayed at this default resolution. However, when the
pixel size of the original image is more than 256x256 (512, 1024, 2048, and 4096),
you can enhance the resolution of the 3D view by selecting the appropriate sampling
number (1, 2, 4, 8, or 16; see Figure 9-3-2). However, increment of the image pixel
size is less effective since this may need larger memory but cannot show remarkable

enhancement of the image’s resolution.

Resolution
Sampling: |2 o
1
Transform
Y. 72"

Rotation: 132 142
Scale: | L6 0,733 4
Translation: 1] -

[JIsotropic Z Scale

Figure 9-3-2. Sampling numbers

B Sampling Number

Changes the number of sampling data points in the line. Sampling number is
automatically set to as follows: the number of data points + sampling number =256.

Sometimes the number of data points collected for a line exceeds the number
of pixels on the 3D Image display panel. In this case, you should select the
reasonable sampling number (see Figure 9-3-2) to enhance the resolution of the 3D
displayed image. When you open a new image, the sampling is selected
automatically to display 256 data points for a line. To adjust the display for higher
resolution images, you should set the sampling numbers manually. For example,
when the pixel size of the original image is 1024, the sampling number is automatically
converted to 4 (in order to reduce its pixel size to 256x256 1024 should be divided by
4), but you can enhance the resolution of the 3D image by selecting a smaller number

for sampling the data (when the number is 1 or 2, the image pixel size is 1024 or 512).
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9-3-2. Transform

Allows you to alter the viewing angle and the scale of the 3D image.

you can translate the 3D rendered image in the z direction.

Also,

Figure 9-3-3 shows the

3D image view that the Transform functions are applied to the 3D rendition of an

image.
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Enable Overlay

Drag image to =

Resolution
Sampling:
Transform
X i z:
Rotation: | -a13|[ 83 23| [(save )
Scale: | | I 0.2[8]
Translation: | ol ol o3
Isatro
Light

i Z:
Luminosity: 1 0 0 Y 0
Of

ff  Low High

X
1

Reflexibilty: 1 1 111 100 0 Y
Off Low High

Enable Ambient Light
Option
Enable Perspective  [] Show Wire Frame
Show XY Axis Show Z Axis
Fill Border [ Use Enhanced Color
Enable Overlay

Drag image to =
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Figure 9-3-3. Transformed 3D image
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B Rotation

Changes the viewing angle of the image by rotating the 3D image. You can
rotate the image plane around the x, y and z axis by entering the rotation degrees or
by using the spin buttons next to the Rotation text fields for X, Y and Z respectively.
You can change the viewing angle from -180 to 180 in x, y and z direction. The
Rotation angle can be saved by clicking ‘Save’ button in Transform Panel. After save,
all the images that opens in 3D Analysis View will be based on previous saved value.
When clicking ‘Restore Defaults’ button, all the values will be set as default value. You

must click ‘Save’ button if these values need to be saved.

e X:changes the viewing angle of the image in the x direction
e Y: changes the viewing angle of the image in the y direction

e Z: changes the viewing angle of the image in the z direction

B Scale

You can alter the scale of the 3D rendered image in the horizontal (X, y) and
the vertical (z) directions. Also, you can manipulate the scale by rolling the mouse
wheel. When adjusting the scale using the mouse wheel, the ratio between X, Y, and Z
axis on the image will be preserved. The ‘Isotropic Z scale’ check box fits the z scale
to the maximum scale of x, y. Consequently, you will see an image that is similar to

the real surface.

e X: alters the scale of the 3D image in the x direction
e Y: alters the scale of the 3D image in the y direction

e Z: alters the scale of the 3D image in the z direction

B Translation

You can change the position of the 3D image in XYZ direction. Also, you can

change in XY direction with dragging mouse and control key on keyboard.
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9-3-3. Light

Changes the position of the simulated light source. By default, an ‘Ambient
Light’ is turned on when you enable the 3D view. The ‘Ambient Light’ is the default
light that commonly exists everywhere, similar to sunlight. It is used to minimize the
variation of light effects among various shaped images.

In addition to an ambient light, there is another light source that may be
adjusted by the user. You can change the position of the light source by specifying the

position in x, y, and z direction.

B Position

e X: moves the position of the simulated light source in the x direction
¢ Y: moves the position of the simulated light source in the y direction

e Z: moves the position of the simulated light source in the z direction
B Luminosity
You can increase or decrease the luminosity of a 3D rendered image by
adjusting the slider from Low to High.
B Reflexibility
You can increase or decrease the reflexibility of a 3D rendered image by
adjusting the slider from Low to High.

B Enable Ambient Light

You can turn on or off the '’Ambient light' by selecting or deselecting it in the

‘Ambient light’ check box, respectively.
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9-3-4. Option

B Enable Perspective

Enables the perspective 3D display. Figure 9-3-4 shows two images
selected (above) and deselected (below) the ‘Enable Perspective’ option in the 3D

view.
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Figure 9-3-4. Enable Perspective
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B Show Wire Frame

Shows the wire frame display of the image. Figure 9-3-5 shows two images

deselected (above) and selected (below) the ‘Show Wire Frame’ option in the 3D view.
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Figure 9-3-5. Show Wire Frame
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B Show XY Axis

Shows the X and Y axes. Figure 9-3-6 shows two images selected (above)

and deselected (below) the ‘Show XY Axis’ option in the 3D view.
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Figure 9-3-6. Show XY Axis
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B Show Z Axis

Shows the Z axis.

Figure 9-3-7 shows two images selected (above) and

deselected (below) the ‘Show Z Axis’ option in the 3D view.
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Figure 9-3-7. Show Z Axis
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B Fill Border

Fills the border of the image. Figure 9-3-8 shows two images selected

(above) and deselected (below) the ‘Fill Border’ option in the 3D view.
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Figure 9-3-8. Fill Border
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B Use Enhanced Color

Changes the coloring scheme to Enhanced Color. Enhanced color uses the
change of a pixel relative to its neighbors instead of its absolute value. Figure 9-3-9

shows an image with enhanced color on.

Figure 9-3-9. Use Enhanced Color

B Enable Overlay

You can overlay another image on to the currently opened one. Click and
drag an image from the navigator to the box indicated in Figure 9-3-10. This will
change the coloring of the rendered image to reflect the overlaid image.

The images must be of matching sizes for this feature to work properly.
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Figure 9-3-10. Image Overlay
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9-3-5. Restore Defaults

Restores parameter values to the original default settings provided with the

software. Figure 9-3-9 shows two images before (above) and after (below) click the

‘Restore Defaults’ button in the 3D view.
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Chapter 10. Multi View

In the Multi view, you can display and export or print out several images
simultaneously. All images will include a file name and a palette panel indicating the
contrast level and data range. Up to 6 images can be displayed at once for a multi
image report. You can arrange several images in the Multi view using the following

procedure:

1. Load multiple images into the Navigator view from your image
directory.

2. Enable the Multi view.

3. Drag and drop images from the Navigator view to the Multi view.

4. Individually adjust the contrast level and range using the palette panel
of the selected image.

5. Print and Export the multi images if desired

Figure 10-1 shows the procedure to generate multi images report in the Multi

view.
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Figure 10-1. Procedure to generate multi images
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10-1. Multi View

To enable the Multi view, select the ‘Analysis>Multi’ in the Menu or click the
Multi tab below the menu bar. You can display up to 6 images at once in the Multi
view. When you want to eliminate displayed images from the Multi view, click the
‘Delete All X button that is positioned at the bottom of Multi View.

Figure 10-1-1 shows the Multi view which shows the initial screen, two images
loaded view, four imaged loaded view and six images loaded view. You can see that

as the images are added into the multi view, their size become smaller.

| , I NI Vi

: a7l 1 O i - E\\\\\l\\\\
I j,liijﬁ I P ﬁl.jl I ‘\!\\%-\-\}*‘fﬁ 8

Lo AR SN O <7 7 L Oy 7 T . W -, |
e S % S X % \ b -
| S | Zot et o . i

Figure 10-1-1. Multi View with different numbers of images loaded.

10-2. Bring Images into the Multi View

It is simple for you to bring images for Multi view. Only you have to do is to
drag and drop images from the Navigator view into the Multi view (see Figure 10-1).
One image can be loaded into the Multi view at one time. Up to 6 images can be
loaded into the Multi view. The more images in the Multi view, the smaller size of the

images. If you want to delete an image, click the ‘Delete Selected one X" button on
the left top of the individual image. If you want to delete all images, click the ‘Delete All

X button on the bottom of Multi view.
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10-3. Adjust the Contrast Level and Range

You can adjust the contrast range and level using the individual palette pane
or ‘Use Enhanced Color#’ for each image in the Multi view. How to adjust the
contrast level or range is like that of other analysis views. Please refer Section 3-2.
Palette Panel, for more information about changing the contrast range and level. Also,
if you want to use enhanced color for all displayed images, click the ‘Use Enhanced

Color AlI'E" button on the bottom of the Multi view.

10-4. Compare Images

A figure such as a Cross + Rectanglelj, or EIIipseO, can be inserted in
an image to help analyze the image in Multi View. On the bottom of the Multi View

Image display panel, click the desired figure icon, and then click the desired location of

the image and drag the figure to the appropriate size.

nm NanoWire

o

.l
-

Figure 10-4-1. Compare Images using figures

B Changing Shape

When the figure’s size needs adjustment, click the figure on image, then click the
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circular tracker and drag the figure to the appropriate size. When the figure’s angle
needs adjustment, click the figure on image then click the green rotation handle and

drag it to the appropriate direction.

B Deleting

Select the desired figure to delete then press the [Delete] key on the keyboard.

H Moving

Select the desired figure to move then click and drag.
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Chapter 11. Crop

In the Crop process, you can select several parts of an image that you are
interested in. The Crop processing tool allows you to eliminate “bad data” from an
image file, thus making it easier to selectively process the true or reliable data in the

same file.

11-1. Crop Process Dialog

To open the Crop process dialog, select ‘Process>Crop’ in the Menu or click
the ‘Crop’ icon B in the Toolbar. As shown in Figure 11-1-1, the Crop process
dialog is composed of two panels, the Image display panel and the Zoom Image
display panel.

In the Image display panel, on the left side of the Crop Process dialog, you will
see a red outlined rectangle. You can use this rectangle to select the region you
want to crop. You can control the size of the region to be cropped and move it to the
desired area. To magnify and reduce the selected region, drag and drop the cursor
which is generated at any of the rectangle’s four corners. When the selected region
needs to be rotated, click the green rotation handle and drag it to the desired rotation
direction. Alternatively, you can enter numbers into the X/Y Size and angle fields.

Too move the rectangle, drag and drop the four-arrow cursor that appears
when the cursor is positioned within it.

The Zoomed Image display panel to the right of the Image Display Panel
shows the enlarged image of the selected region (red bordered box in the image).

You can preview a newly cropped region in this Image display panel.
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Figure 11-1-1. Crop process dialog

11-2. Crop an Image
In general, follow these steps to crop an image (see Figure 11-2-1):

1. Load animage file into the Analysis view from the Navigator view.

2. Select ‘Process>Crop’ or click the ‘Crop’ icon B in the Toolbar
to display the Crop process dialog.

3. Move the crop rectangle over the region to be cropped.
Increase or decrease the size of the selected region and/or
rotate the region as desired.

4. Once you are satisfied with the new area displayed in Zoom
Image Display panel, click the ‘Execute’ and ‘OK’ button to
create a newly cropped image in the Navigator view. The
image will be generated with a default name of ‘original
name+cropped.tiff. The image will be automatically displayed
in the image display panel.

5. Save the cropped image as another file name for further image
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processing and analysis.

Ciick!andbrag!" s
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Figure 11-1-2. Rotation

NOTE!

Cropping a local region of an image produces a new, processed image that
can be saved to your hard disk or printed. Cropping an image does not affect the
original data unless you press the Save button.

NOTE!

The Cropping procedure is only possible with image in the Image Display
panel.

NOTE!

After rotation, the image is produced with a 2D Bi-linear interpolation
algorithm.
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B X/Y Size

Crops Rectangle’s X/Y size

B Equal Size Check Box

When this box is checked, X/Y Size input text-field will be one. Any input in this
text-field will adjust both X/Y size.

B Angle

Rotates the Crop Rectangle. Crop rectangle will rotate counter-clockwise as the
Angle increases in the positive direction. Values between 0 ~ 359.9° can be used in

the input box.

B Execute

Crops the selected region and displays the new image in the Image Display panel.

B Undo/Redo

Undo/Redo previous action.

H OK

Saves cropped image in Image Display panel and closes Crop process dialog.

B Cancel

Cancels Crop process and closes Crop process dialog.

B Reload

Loads the original image in Crop process dialog.
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Chapter 12. Arithmetic Filter

In order to get better presentations and the best measurement results, the
Arithmetic Filters are used to reduce various noisy features in the image. The
Arithmetic Filter processing techniques in XEI are divided into four classes: Smoothing,
Sharpening, Edge Enhancement, and Custom. This chapter describes the functions
under each of these four classes.

Most of the filters use an n x m filtering kernel matrix, where n and m are odd
integers so that there is a unique center of the kernel matrix. A filter places this
kernel on a matrix of image pixels and uses the values of neighboring pixels to

determine the new value for the center pixel.

12-1. Filter Process Dialog

To open the Filter process dialog, select the ‘Process>Filter’ menu or click the
‘Filter’ icon 4 in the Toolbar. As shown in Figure 12-1-1, the Filter list box has four
groups of filters. Those groups are ‘Smoothing’, ‘Sharpening’, ‘Edge Enhancement’,
and ‘Custom’. Each filter group has several different types of filters. After you
select the desired filter, set the kernel width and height. The meaning of each item in

the Filter process dialog is described in detail below.
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Figure 12-1-1. Filter process dialog

12-2. Smoothing

The smoothing processes reduce sharp edges and small variations. This

effectively removes glitches and is useful therefore.

12-2-1 Mean

The Mean Filter’'s characteristics are determined by the kernel height and
width. A larger kernel size results in more blurring. Therefore, an excessive kernel
size may produce unexpected effects on your data.

After the filter calculates the average of the pixels bounded in the kernel
matrix, the average is set to be a new pixel value located at the center of the kernel.
If you use a 3 by 5 kernel, for example, this filter places this kernel on an image and
then calculates the average of 15 (= 3 x 5) image pixels bounded in the kernel to

substitute each pixel value to the average.

150



Chapter 12. Arithmetic Filter

12-2-2 Gaussian Blur

The Gaussian Blur Filter’s characteristics are determined by the kernel height
and width, and the standard deviation. These can be varied with separate values for
the X and Y dimensions. The pixel is set to the center value of the Gaussian curve

that best fits the data points.

12-2-3 Median

The Median filter is an effective method for removing outliers or shot noise in
an image. At first, the Median filter sorts the pixel data to find the median of the
pixels bounded in the kernel matrix. Then, the median value is used to replace the
value of a pixel that is over the acceptable range. If you use a 3 by 5 kernel, for
example, this filter places this kernel on an image and calculates the median of 15 (=
3 x 5) image pixels bounded in the kernel. The calculated median is set as a new
pixel value located at the center of the kernel.

The median filtering is more reliable than the average filtering in the cases
such as the one in the following example:

When one value deviates extremely from the others and shifts the mean as in
this set “1, 3, 4, 5, 9, 10, 200, 14, 15, 17, 19”7, the median is 10 and the average of this
setis 297/11=27. If the out of range value is considered to be a bad data point and is
then excluded from the calculation of the average, the more accurate average would
now be closer to the median: (297-200)/10=9.7.

12-2-4 Low Pass

The Low Pass filter has a fixed kernel size of 3x3. The value “Weighting

Factor” is represented in the kernel by n. The term 1/(n+2)2 can be factored out, so the

kernel can also be represented as the product of (n+2)'2 and the values in the following

table.
1/(n+2)* n/(n+2)° 1/(n+2)? 1| n |1
n/(n+2)* n’/(n+2)* n/(n+2)° n| n” | n
1/(n+2)? n/(n+2)? 1/(n+2)? 1| n |1
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12-2-5 Conservative

The Conservative filter removes extreme points. For a given pixel, the
surrounding pixels are considered. The number of neighboring pixels is determined
by the Kernel Size parameter.

If the pixel is the highest point within the kernel, its value is lowered to the
next-highest value within the kernel. If it is the lowest point, then its value is
increased to the second-lowest value within the kernel.

This operation is performed simultaneously on all of the pixels, with the effect

of removing extreme points and maintaining the same median value.

12-3. Sharpening

Sharpening filters are used to make smaller features more noticeable. They

increase the difference between neighboring pixels.
12-3-1 High Pass

High Pass is the first of the Sharpening filters. Its kernel size is variable but
must be a square. The center pixel is multiplied by the square of the length of the
square; all other pixels are given a weight of -1.
12-3-2 Laplacian of Gaussian

The Laplacian of Gaussian allows the user to perform both the Gaussian Blur,

then the Laplacian Edge Enhancement on an image in one go. However, the X and

Y kernel size and standard deviation values for the Gaussian blur are equal.

12-4. Edge Enhancement

Edge Enhancement function create images of the gradient between pixels.

This allows the user to better distinguish edges of sample features.
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12-4-1 Roberts

The Roberts filter can be applied in the four cardinal directions, denoted as
“East,” “West,” “North,” and “South.” This filter sets the value of each point as the
difference between the point and the point adjacent to it in the direction of application.
For example, if one chose East, pixel (5,5,10) with a neighbor (4,5,8) would now have
the value of (5,5,11-8). One can also say that the value of a pixel is set to be the sum

of itself and its neighbors when they are multiplied by the following kernel (for the East

direction):
0 0 |0
-1 110
0 0 |0
12-4-2 Sobel

The Sobel filter differs from the Roberts filter in that it weighs the neighboring
pixels differently. Instead of finding the difference between the actual pixel and one

neighbor, it finds the difference between pixels on opposing sides:

-1 0 |1
-2 0 |2
-1 0 |1

12-4-3 Laplacian

A Laplacian filter is different from a Roberts or Sobel filter in that it finds the
differential between a pixel and its neighbors in the four cardinal directions. Its kernel

is as follows:

0 |-1 |0
S VR |
0 |-1 |0
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12-5. Custom

Custom filters can be applied to images. User-defined kernels are limited to

a size of 3x3.

12-5-1 3x3 Convolution

The user may decide what weight is given to each pixel in the kernel which

has a 3x3 size.

NOTE!

Applying the Arithmetic Filter process to an image produces a nhew,
processed image that can be saved or printed as a new file. Filtering does not
change the original data unless you click the Save button.
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Chapter 13. Flatten

The Flattening processing tool removes artifacts that result from the slope
and curvature produced by the scanning process. These artifacts can affect the
height data of the image and make the image difficult to interpret.

Slope results from the fact that the sample surface will always be tilted to
some extent relative to the plane of the XY scanner. Also slope can be caused by
the XY scanner not moving in a plane perpendicular to the Z scanning direction.
Curvature is mainly caused by the out-of-plane motion of the XY scanner while
scanning the sample.

During the flattening process, XEI first obtains the ‘fitting curve’ for each scan
lines in the image. ‘Fitting curve’ is an estimation of the ‘slope’ or ‘curvature’
introduced in the image. Then, from each scan line in the image, XEI ‘subtracts’ the
corresponding fitting curve. As a result, the ‘offset’ between the each point on the
scan line and the each corresponding point on the fitting curve is obtained. This
‘offset’ is assigned as a new data for the each point. Figure 13-1 shows short

example showing flattening applied to a single line.

1st order fitting
© curve

Scan Line

Distance between
the fitting curve and
the scan line

~ - - - - Reference line
Flattened

Scan Line

Figure 13-1. 1D example of the flattening
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13-1. Flatten Process Dialog

To display the Flatten process dialog, select ‘Process>Flatten’ in the Menu or
click the ‘Flatten’ icon ke in the Toolbar. Figure 13-1-1 shows the Flatten process
dialog which is composed of several parts. The Image display panel shows the
original image and the processed image. At the upper-right side of the Image display
panel is the Region selection toolbar composed of several buttons that include and
exclude regions for flattening. At the lower-right side of the Image display panel are
several parameters used to flatten an image. At the right side of the Image display
panel is the Line Profile panel which displays the average height profile and the fitting
curve for flattening an image. Below the Image display panel is the Histogram of the

entire image for height restriction.
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Figure 13-1-1. Flatten process dialog

The Flatten process dialog provides some parameters that are useful for applying

different flattening techniques. These are described further in the following section.
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13-1-1. Image Display Panel

The Image display panel displays an original image and a flattened image.
After adding regions, it also shows the regions as partially transparent shapes. If the
Scope is set to ‘Line’, you will see a movable line locator in the Image Panel (for
example, the red horizontal line with the two-arrow cursor in an image of Figure 13-1-
1).

13-1-2. Region Selection Toolbar

The Region selection toolbar is composed of several buttons that include or
exclude any regions in an image. Data points that are in the included regions are
collected to calculate fitting curves and data points that are in the excluded regions are

not used. The function of the region selection toolbar is summarized below.

¢ Inclusion - Sets selected regions to be included in the fitting curve

e Exclusion - Sets selected regions to be excluded from the fitting curve
e Rectangle - Selects a rectangular region

o Ellipse - Selects an elliptical region

e Polygon - Selects a polygonal region

e Entire region - Selects entire image

B To select aregion type

To specify the features of the image to be included and excluded, select the
region type (rectangle, ellipse, and polygon) and create the regions in the image that
will be included or excluded areas of the image. The shape and size of the selected
region can be adjusted by dragging each small round tracker which is generated when
you click any location within the selected region.

Especially, in the case of the polygonal region, after selecting the polygon in
the Region selection toolbar, click the cursor onto any place where you want to create
the region and then, move and click once onto each point of the polygon. Changing
the shape and size of the polygon region is performed by the same steps described in

the Region Analysis section. In addition, to move the selected region you have
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already created, click the cursor in the selected region and drag the four-way arrow to
reposition the region.

After selecting and grouping regions to be included and excluded for flattening,
the Line profile automatically calculates and displays the average height profile and

the fitting curve.

13-1-3. Histogram Panel

As shown in Figure 13-1-2, the Histogram panel shows a bar graph showing
the distribution of heights in the image. The x axis is the height of data points in the
sample surface, and the y axis is the number of data points. The Histogram panel
has a pair of height restriction markers that restrict height range of data. One marker
that has a flag directing right represents a lower limit and the other marker that has a
flag directing left represents an upper limit. You can drag these markers to
determine the height range to be included. Data points that have heights in the
restricted height range are included and that have heights out of the range are
excluded when calculating fitting curves.  Included heights are painted with the
original palette and excluded heights are painted with violet in the Palette panel,

Image display panel, and the Histogram panel.
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Figure 13-1-2. Height restriction markers in the histogram

13-1-4. Flattening Parameters

B Scope

The Scope is a range for collecting data and calculating a fitting curve that will
be used for flattening. The flattening process collects data in the scope to calculate a
fitting curve. The calculated fitting curve will be subtracted from the original image
during flattening. There are two scopes: Whole and Line.

If the ‘Whole’ scope is selected, included data are used to calculate an
average line profile and its fitting curve. The average line profile shows overall
features of the image and the fitting curve calculated from this average line profile
shows an overall distortion of the image. The fitting curve is subtracted from the
entire image. The Line Profile panel displays this average line profile and its fitting
curve.

If the ‘Line’ scope is selected, included data are used only to calculate a fitting
curve for each line profile. Each fitting curve is subtracted from each line profile. In
this scope, a movable line locator appears on the Image display so that you can

examine a line profile at the locator and see its fitting curve in the Line Profile panel.
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You can move this line locator easily by dragging it. Whenever you move the line
locator, the line profile is automatically updated.
The 'Difference’ scope takes the first derivative of the data, and uses this data

for flattening. This helps to reduce deviations in height offset between adjacent lines.

B Orientation

Orientation indicates the direction of the flattening process. If the ‘Horizontal’
orientation is selected, a horizontal slope and curvature will be removed. The same
manner is applied for the “Vertical’ orientation.

In the ‘Whole’ scope, all line profiles of the selected orientation are averaged
to calculate a fitting curve for an overall image. In the ‘Line’ scope, a movable line
locator that lies in the selected orientation appears on the Image display panel. You
can examine a line profile of the selected orientation as well as the corresponding
fitting curve.

In general, you may need to flatten an image both in the horizontal and
vertical directions to eliminate all directional slope and curvature components from the

image.

B Regression Order

The Regression order is the order of a regression polynomial selected for
flattening. A fitting curve is calculated by polynomial regression. There are four
possible regression orders: the zeroth, first, second, and the third. Each is denoted
by 0, 1, 2, and 3. The zeroth order subtracts a constant from each line. The first
order is used to remove a slope caused by a slanted scan plane relative to the sample
plane. The second order is used to remove curvature caused by a bending motion of
the XY scanner. The third order is for eliminating more complex distortions, but is

rarely used.

B Zero Basement

The Zero Basement parameter will add a constant value to every pixel so that

the average value of the data is 0.

13-1-4. Line Profile Panel

The Line profile panel displays both the line profile (red curve) and the fitting
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curve (blue curve) for flattening this Line Profile panel. In the Whole scope, this
profile is an overall line profile. In the Line scope, this profile is a line profile located
by a line locator in the Image display panel. The red curve is the line profile only for
the included data and dashed lines are displayed for excluded data. A blue curve
displayed simultaneously with the red curve is a fitting curve for flattening. The fitting
curve is calculated only with the included data. Figure 13-1-3 shows two images
before (left) and after (right) flattening. You can confirm whether the flattening
process is executed well to see that the fitting curve becomes “flat” after executing the

process.
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Figure 13-1-3. Line profiles with fitting curves

13-2. Flatten an Image

Flattening is carried out through three processes. As soon as you open the
Flatten process dialog, the software determines automatically the average curvature
and slope of the image. Then, the software calculates a set of values that will
compensate for the slope and curvature. Finally, you can have the software subtract
the compensating values from the data points of the image.

You can follow this general steps for eliminating the slope and curvature of the
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image (see Figure 13-2-1):

1. Load the image you want to flatten into the Image display panel.

2. Select the Flatten menu or click the ‘Flatten’ icon i to open the Flatten
process dialog.

Select the Orientation for flattening, appropriate Scope.

4. Create regions of the image to be included and/or excluded from the
calculation of the fitting curve. If necessary, restricts heights using
height restriction makers in the Histogram panel.

5. Select the Regression order, which determines the type of slope or
curvature to be eliminated.

6. Adjust some parameters to get desirable fitting curves and click the
‘Execute’ button if desired.

7. Save, export or print this image for further processing and analysis if

desired.

It may be necessary to flatten an image in both the horizontal and vertical
directions and also to execute the image flattening using more than one regression

order in subsequent steps to remove both curvature and slope from an image.

NOTE!

Applying the Flattening process to an image produces a new, processed
image that can be saved or printed as a new file. Flattening does not change the
original data unless you click the Save button..

Figure 13-2-1 shows the summarized procedure to flatten the selected region

in an image.
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Flatten
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Figure 13-2-1. Procedure to flatten an image
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Chapter 14. Deglitch

Deglitching is used to remove glitches from an image. A glitch is a small
artifact in an image that does not represent the true surface topography. You can
apply deglitching in both the horizontal and vertical directions.

Usually, glitches occur in the fast scan direction and appear as discontinuities
or streaks in an image. Long glitches are sometimes caused by loose, unidentified

particles on the surface that are dragged by the tip.

14-1. Deglitch Process Dialog

To open the Deglitch process dialog, select ‘Process>Deglitch’ in the Menu or

click the ‘Deglitch’ icon " in the Toolbar.

Image Display Panel Zoomed Image Display Panel Shape Selection Toolbar

K Deglitch

nm
607

Figure 14-1-1. Deglitch process dialog
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As shown in Figure 14-1-1, the Deglitch process dialog is composed of two
main parts; Image display panel and Zoomed Image display panel. At the left side,
the Image display panel shows the original or processed image. At the right side,
there is the Zoomed Image display panel with a Shape selection toolbar that is used to
perform the glitch removal. Horizontal and vertical lines may be used as well as

points.

14-1-1. Image Display Panel

The Image display panel displays an original image and a deglitched image.
There is a red outlined square that indicates a zoomed region. After adding lines or

points for deglitching, they will be displayed as dashed lines (Figure 14-1-1).

14-1-2. Zoomed Image Display Panel

The Zoomed Image display panel displays the magnified image of the
zooming square. The Zoomed Image display panel magnifies the image dynamically
while the zooming square is moved. Figure 14-1-2 shows that some glitch (see white
outlined circles) disappear in the image after deglitching it in the Deglitch process

dialog.

Figure 14-1-2. Deglitched image
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14-1-3. Shape Selection Toolbar ¥ | —*

The Shape selection toolbar has both a horizontal and a vertical line button
and a point. If you select the horizontal or vertical line button, you can generate
related lines in the Zoomed Image display panel pixel by pixel (dashed line as shown
in Figure 14-1-1). The drawn lines are also displayed in the Image display panel.

You can deglitch the lines or points that you selected by clicking the ‘Execute’ button.

14-2. Deglitch an Image

Deglitching is processed according to the rule that glitches are replaced by the
lines of pixels through the average filter. For deglitching a horizontal line, every pixel
in the line you select is substituted by the average of its top neighbor and its bottom
neighbor. A line can be selected that extends across the entire image. For
deglitching a vertical line, every pixel in the line you select is substituted by the
average of its left and its right neighbor. Points are deglitched by getting the average
of four neighbor pixels, one from each cardinal direction.

The procedure to deglitch an image is as follows (see Figure 14-2-1):

1. Load the image you want to deglitch into the Analysis view.

2. Select ‘Process>Deglitch’ in the Menu or click the ‘Deglitch’ icon B
in the toolbar to display the Deglitch process dialog.
Move the zooming square to where you want to deglitch in the image.

4. Decide what shape (line or point) to deglitch with. Place the cursor
in the Zoomed Image display panel and click the cursor onto glitches.

5. Preview the changes in the Image display panel after clicking the
‘Execute’ button executing the deglitching process. Update the
deglitched image into the Analysis view if desired.

6. Save, export, or print this processed image for further analysis and

processing

NOTE!

Applying the Deglitching process to an image produces a new, processed
image that can be saved or printed as a new file. Glitch removal does not change the
original data unless you click the Save button.
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Figure 14-2-1. Procedure to deglitch an image
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Chapter 15. Region Deglitch

Region Deglitching is used to remove glitches from an image. A glitch is a
small artifact in an image that does not represent the true surface topography. The
Region Deglitch process allows you to remove glitches in the horizontal and vertical
directions. The Region Deglitch process allows removal of artifacts in larger areas,

or removal of multiple artifacts in one go.

15-1. Region Deglitch Process Dialog

To open the Region Deglitch process dialog, select ‘Process>Region Deglitch’

in the Menu or click the ‘Region Deglitch’ icon ?1 in the Toolbar.
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Figure 15-1-1. Region Deglitch process dialog

As shown in Figure 15-1-1, the Region Deglitch process dialog is composed
of four main parts; Image display panel, Zoomed Image display panel, Histogram, and
Parameter Control. At the left side, the Image display panel shows the whole image.
At the right side, there is the Zoomed Image display panel that shows the region that

is being deglitched.

15-1-1. Image Display Panel

The Image display panel displays the whole image that is currently being
processed. There is a red rectangle that indicates the selected and zoomed region.
The zooming rectangle can be moved by clicking dragging it, and resized by clicking

and dragging one of its corners.
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15-1-2. Zoomed Image Display Panel

The Zoomed Image display panel displays the magnified image of the
zooming square. The Zoomed Image display panel magnifies the image dynamically
while the zooming square is moved. In Region Deglitch, this area also represents the

region that is being deglitched.

15-1-3. Histogram

The deglitch can be performed to remove artifacts that result in apparent low
or apparent high values in the image. When these are determined manually, the

histogram is used to set these upper or lower bounds.

15-1-4. Parameter Control

There are two settings that can be adjusted in Region Deglitch.
B Auto
When this is selected, the software automatically fits a Gaussian
curve to the histogram and considers points that are above or below
the main curve to be due to artifacts. When unselected, the
Histogram is used to manually determine the upper and lower

bounds.

B Upper, Lower, Both
When in Auto mode, you can decide to only consider points on the
upper or lower extreme to be artifacts. If Both is selected, both

upper and lower extremes will be considered artifacts.

15-2. Region Deglitch an Image

Region Deglitching is based on the assumption that within the selected region,
pixels above or below a certain threshold are caused by noise, and that their actual
value can be more accurately represented by interpolating a value from the
surrounding data. Within the region defined by the zooming square, every point that

is considered too high or too low is given a new value based on its closest non-artifact
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neighbors in the four cardinal directions.

The following procedure can be used to perform Region Deglitch on an image

with the Auto setting.

1.

2
3.
4

Open the file, and enter the Region Deglitch process.
Select the area you wish to deglitch.
Select the threshold type (Upper, Lower, or Both).

Click the ‘Execute’ button.

Figure 1-2-1 shows this process, and Figure 1-2-2 shows a deglitched image.

Figure 15-2-1. Auto Region Deglitch
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Figure 15-2-2. Auto Deglitched Image

The following procedure can be used for manual selection of the thresholds.

1. Open the file, and enter the Region Deglitch process.

2. Select the area to region deglitch.

3. Deselect Auto, and move the Histogram cursors to limit the points to
the glitches. Excluded points will be shown in purple.

4. Click the Execute button.

NOTE!

Applying the Region Deglitching process to an image produces a new,
processed image that can be saved or printed as a new file. Glitch removal does not
change the original data unless you click the Save button.
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Figure 15-2-4. Manual Deglitched Image
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Chapter 16. Fourier Filter

You can use the Fourier Filter to remove unwanted frequency components
from your data. A Fourier Filter is most commonly used to remove periodic noise that
appears in an image, for instance, due to electrical noise or mechanical vibrations. A
2-dimensinal power spectrum of an image may be used to identify periodic noise. In
the power spectrum, periodic noise will appear as a vertical band running through the
center of the power spectrum. This noise can be removed by applying a Fourier
Filter. Also, a Fourier Filter may be used to remove a selective frequency component
from actual surface data. This technique is often applied in presenting atomic lattice
data. In this case, a Fourier Filter is applied that includes only the frequencies that

represent the symmetry of the atomic lattice.

16-1. Fourier Filter Process Dialog

To open the Fourier Filter process dialog, select the ‘Process>Fourier Filter’
option in the Menu or click the ‘Fourier Filter’ icon in the Toolbar.

As shown in Figure 16-1-1, the Fourier Filter dialog consists of an Image
display panel and a 2D power spectrum display. On the left side, there is the Image
display panel which shows the original image to which the Fourier Filter will be applied
and will also show the transformed image after you have applied the Fourier Filter.
At the right side of the Image display panel is a 2-dimensional power spectrum which
includes a palette panel as well as tools used to either include or exclude regions

(rectangle, ellipse, polygon or entire region) to be filtered.
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Figure 16-1-1. Fourier Filter process dialog

16-2. 2D Power Spectrum

When you open the Fourier Filter process dialog, the Fourier transform of the
selected image is automatically calculated. The resulting power spectrum is
displayed in a different color. Figure 16-2-1 shows the general 2D power spectrum
which all height data in the spatial domain are converted to the frequency domain after
Fourier transform. Peaks in the power spectrum appear bright on a dark background,
and also, different colors are displayed in different intensities of frequency
components in the data. You can adjust this scale using the palette panel to see
various peaks in the power spectrum more clearly.

The unit of the z scale in the power spectrum is displayed at the left side of
the palette panel as Axpm?, pm xpm?, Vxum?, Axnm?, nm xpm?, Vx A% and so on that
depending on the unit you selected as an input signal in the Input configuration dialog
when the image was initially acquired. The units of x and y in the power spectrum
are 1/um, that is, the reciprocal of each unit of x and y in the image.

In a power spectrum, the x scan direction is displayed horizontally and the y
scan direction is displayed vertically. Lower frequencies are near the origin and
higher frequencies are further from the origin. Peaks in the power spectrum are
symmetric about the origin.

Each spatial frequency in the real spatial image is represented by a peak in
the power spectrum. Peaks can be due to actual surface periodicities such as the

spacing between lines on a grating of a standard sample or the spacing between rows
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of atoms on a graphite surface. Peaks may also result from periodic noise. To
apply the Fourier Filter to unwanted frequency components, remove or reduce the

intensities of the unwanted peaks in the power spectrum.
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Figure 16-2-1. 2D power spectrum

16-3. Apply the Fourier Filter to an Image

A selective Fourier filter allows you to remove specific frequency components
from the power spectrum of an image. This process is commonly used to remove
peaks attributed to periodic noise. Furthermore, it can be useful when you wish to
take an image with only chosen periodicities by including only those peaks in which
you are interested.

In Fourier filtering, you select a region type to be used for including or
excluding frequency components in the power spectrum. You can remove all
periodic noise by excluding frequency components within the included region.

Since peaks in the power spectrum are reflected across the origin, both a

selected region and its reflected region will be generated together.
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You can apply the Fourier filter to an image by following these general steps
(see Figure 16-3-1):

1.
2.

Load the image you want to apply Fourier Filter into the Analysis view.
Open the Fourier Filter process dialog by selecting ‘Process>Fourier
Filter’ in the Menu or by clicking the ‘Fourier Filter’ icon on the
Toolbar. When you open the Fourier Filter process dialog, the entire
power spectrum is automatically displayed.

Select a region type (rectangle, ellipse, polygon or entire region) you
wish to use to include or exclude selected frequencies, and draw it
around the desired spectral features in the power spectrum.

Click the ‘Execute’ button to preview the effect of the Fourier Filter.
Update the image in the Analysis view by selecting the ‘OK’ button if
desired.

Save, export, process or analyze the filtered real spatial image.

Figure 16-3-1 shows the general procedure to apply the selective Fourier

Filter and also, you can see a comparison of an original image and a Fourier filtered

image.

Furthermore, Figure 16-3-2 shown below is the atomic lattice image which

the selective frequency components were passed through the Fourier Filter.

NOTE!

Applying the Fourier Filter to an image produces a new, processed image
that can be saved or printed as a new file. This application does not change the
original data unless you click the Save button.
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Chapter 17. Tip Estimation

As the size of the tip is finite, the images obtained by the SPM are affected by
the shape of tip. In professional words, image of the tip is ‘convoluted’ to the image
of the sample surface obtained with the tip (i.e. Tip Convolution). Tip Convolution
generates error in the dimensions of the sample surface measured with the SPM.
Figure 17-1 shows simple example how shape of the tip affects the dimensions of the

hills and trenches measured with the SPM.

Obtained
Image

Path of the tip

True sample
surface

Figure 17-1. Example of tip convoltion

To remove such an affect of the ‘tip convolution’, XEI offers ‘Tip Estimation’
process. During the ‘Tip Estimation’ process, XEI first ‘estimates’ the shape of the tip
used to obtain the image. Then, XEI calculates the artifacts caused by tip and
removes them from the loaded image. (Tip de-convolution)

This part of the manual is mainly focused on how to use the ‘Tip Estimation’
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function of the XEIl. For detailed information regarding the algorithm of the ‘Tip
Estimation’ process, please refer to “Algorithms for Scanned Probe Microscope Image
Simulation, Surface Reconstruction, and Tip Estimation” by J. S. Villarrubia. (‘Volume
102, Number 4, July—August 1997 Journal of Research of the National Institute of
Standards and Technology)

17-1. Tip Estimation Process Dialog

To open the Tip Estimation process dialog, select the item from the Process
menu or click the ‘Tip Estimation’ icon ‘. in the Toolbar.

As shown in Figure 17-1-1, the Tip Estimation dialog consists of two image
display panel, one for the loaded image (Image Display Panel) and the other for the

estimated tip shape (Tip Image Display Panel), and Parameters panel.
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Image Display Panel

Figure 17-1-1. Tip Estimation process dialog

17-1-1 Image Display Panel

The Image display panel is on the left side shows the original image to which
the tip deconvolution will be applied and will also show the transformed image after
you have applied the deconvolution. Image before and after tip deconvolution is

displayed in the Image Display Panel.
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17-1-2 Tip Image Display Panel

2 dimensional representation of the estimated tip shape is displayed on ‘Tip
Image Display Panel’. Also, the estimated tip shape can be saved and loaded for

further analysis.

B Opening & Saving the Estimated Tip Shape

Estimated tip shape can be saved as a tiff file by clicking ‘Save’ button. The
tiff file of the estimated tip shape will be saved under the same directory where the
image loaded for “Tip Estimation’ process is saved. The file name of the saved tip
shape will be in forms of ‘File name of the image loaded for tip estimation
process_tip.tiff.

Saved tip shape can be loaded to the ‘Tip Image Display Panel’ later on and
used as an estimated tip shape for other samples as well. To load the saved tip
shape, click ‘Open’ button and browse to find the saved tip shape. Figure 17-1-2

shows a tiff file of the saved tip shape loaded in 3D view of the XEI.

nm

250 I

150
100+

50 -

Figure 17-1-2. Estimated tip shape saved as tiff file

Saving and loading the tip shape can be useful if you have more than 2
images that have been obtained using the same tip. You can save the tip shape

estimated from one sample and load it to deconvolute other images that have been
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obtained with same tip without repeating tip estimation process.
17-1-3 Parameters Panel

Parameters related to optimization of tip estimation and deconvolution

process are controlled through this panel.

B Priority

User can select to give priority of tip estimation and deconvolution algorithm to
either ‘Speed’ or ‘Accuracy’. When the ‘Priority’ is given to ‘Speed’, XEI uses partial
estimation algorithm to perform fast tip estimation and when the ‘Priority’ is given to

‘Accuracy’, XEI uses full estimation algorithm to perform more accurate tip estimation.

B Tip size

Tip size can be set in units of the ‘pixels’. Selecting an appropriate tip size is
important for good tip estimation results. Typical tip size that gives accurate
estimation result is 0.04 to 0.2 of the image size. For example, if the size of the
loaded image is 20um with 256 pixel size, typical tip size that will give good estimation
result will be 10.24 to 51.2.

B Noise Threshold

Variations that are smaller than this value are ignored during the tip estimation

process as contributed by noise. Typical values range from 2A to 5A.

17-2. Applying Tip Estimation process to the Image

The tip shape will be automatically calculated when the dialog window is
initialized. You can recalculate the tip shape if you have better knowledge of the
actual tip size. Put the size (height and width) of the tip into the appropriate fields
and click the Estimate button. A new estimation will be made.

Once a good approximation of the tip shape has been made, it can be applied
to the image to remove artifacts created by the tip. This can be helpful for images
including sheer slopes. Tip deconvolution is applied to the whole image. You can

estimate the tip shape and apply the estimation to an image by following these general
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steps:

Load the image to which you want to apply tip deconvolution into the
Analysis view.

Select Tip Estimation from the Process menu or click the ‘Tip
Estimation’ icon in the Toolbar.

Input the size of the tip, select priority, and then click ‘Estimate’ to
calculate the shape of the tip. If you had estimated the shape of the
tip that was used to obtain the loaded image.

Click the ‘Execute’ button to preview the effect of the tip deconvolution.
Update the image in the Analysis view by selecting the ‘OK’ button if
desired.

Save, export, process or analyze the new image.

NOTE!

Applying the Tip Estimation process to an image produces a new, processed

image that can be saved or printed as a new file. This application does not change
the original data unless you click Save button.

Figure 17-2-1 shows the resulting image when the estimated tip shape is applied to

the original data.
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Figure 17-2-1. Application of Tip Estimation

In actual experiments, there is special sample designed for tip shape
Accurate tip shape can be obtained when the tip shape is estimated from
Then, the estimated tip shape can be loaded for tip

estimation.
the image of this sample.
deconvolution of other images measured with same tip.
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Chapter 18. Rotate & Flip

It may be desirable to change the orientation of an image. The Rotate & Flip
process can be used to rotate SPM images left or right, or flip the image across one of

its axes. This may be helpful for comparison of images taken at different orientations.

18-1. Rotate & Flip Process Dialog

To open the Rotation & Flip process dialog, select ‘Process>Rotate & Flip’ in

the Menu or click the ‘Rotate & Flip’ icon Il in the Toolbar.

& Rotate & Flip X

nm

200 — 2 Method

Mame: |Flip v |

Parameters

Orientation: | v/

-200 28t

-400
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Figure 18-1-1. Rotate & Flip process dialog

As shown in Figure 18-1-1, the Rotate & Flip dialog has two settings that can

be modified.

18-1-1. Method

You can choose to flip the image or to rotate the image with this option.
Flipping around an axis will invert the value of that axis for every pixel in the image.
Rotating will swap the X and Y axes with different signs.

Crrientation: _ bl

Direckion: | Left b

Left
Right

18-1-2. Parameters

The parameter options allow you to select, for the Flip method, X, Y, or Z.
This determines which axis the image is flipped around. For Rotate, the field
changes to Left or Right, which determines whether the image is rotated counter-

clockwise or clockwise, respectively.

18-2. Rotate & Flip an Image

To rotate or flip an image, perform the following steps:
1. Open the file, and enter the Flip & Rotate process.
2. Select the Method and Parameters for the operation.
3. Click the ‘Execute’ button.

Figure 18-2-1 shows this process for flipping an image around its Y axis.
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Figure 18-2-1. Perform Y Axis Flip
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Chapter 19. Pixel Manipulation

The Pixel Manipulation Process resamples the image to increase or decrease
the number of pixels in the file. This is particularly useful when comparing images of

differing resolutions, as some operations can only work on images of the same

resolution.

19-1. Pixel Manipulation Process Dialog

To open the Pixel Manipulation process dialog, select ‘Process>Pixel

Manipulation’ in the Menu or click the ‘Pixel Manipulation” icon K% in the Toolbar.
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Figure 19-1-1. Pixel Manipulation process dialog

19-1-1. Current Pixel

The current resolution of the file is shown in number of pixels for the X and Y
axes.

19-1-2. Method

You can select which axis to change using the ‘Axis’ drop-down menu: X, Y, or
Both.

The amount by which the selected axis is changed is determined by the
‘Scale’ drop-down menu: Halve the number of pixels, or double them.

19-2. Applying Pixel Manipulation

To apply Pixel Manipulation to an image, perform the following steps:
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1. Open the file, and enter the Pixel Manipulation process.
2. Select the Method.
3. Click the ‘Execute’ button.
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Figure 19-2-1. Perform Pixel Manipulation
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Chapter 20. Unary Arithmetic

The Unary Arithmetic Process can perform several arithmetic operations on

an image.

20-1. Unary Arithmetic Process Dialog

To open the Unary Arithmetic process dialog, select ‘Process> Unary

Arithmetic’ in the Menu or click the ‘Unary Arithmetic’ icon ™2 in the Toolbar.

&2 Unary Arithmetic

Method

Name |Invert v
Invert
Square
Square Root
Execute

300 &

As shown in Figure 11-1-1, the Unary Arithmetic process has one parameter.

Figure 20-1-1. Unary Arithmetic process dialog
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20-1-1. Method
The methods available are Invert, Square, and Square Root.

H Invert

Every pixel is multiplied by -1 in the Z direction.

B Square

Every pixel is squared.

B Square Root

The square of every pixel is taken.

20-2. Applying Unary Arithmetic
To apply Unary Arithmetic to an image, perform the following steps:
1. Open the file, and enter the Unary Arithmetic process.

2. Select the Method.
3. Click the ‘Execute’ button.
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Chapter 21. Binary Arithmetic

The Binary Arithmetic process is used mostly for the direct comparison of two

images.

21-1. Binary Arithmetic Process Dialog

To open the Binary Arithmetic process dialog, select ‘Process> Binary

Arithmetic’ in the Menu or click the ‘Binary Arithmetic’ icon + inthe Toolbar.

4 Binary Arithmetic

Method

S T

Figure 21-1-1. Binary Arithmetic process dialog
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As shown in Figure 21-1-1, the Binary Arithmetic dialog has two parameters,
Xand.

18-1-1. Method

The X and Y fields denote the left and right images. The currently loaded
image is shown on the left, and the second image which is to be added to the opened
image is shown on the right.

The values in the X and Y fields determine their weight in the result. As the
type of data can differ between images, such as with Topography and Error images, a

trial and error approach is recommended to find satisfactory values for these fields.

21-2. Applying Binary Arithmetic

To apply Binary Arithmetic to an image, perform the following steps. In this

example, the MFM data of a hard drive is added to the Topography signal.

1. Open the file, and enter the Binary Arithmetic process.

Bote2ME ARE S

100+

100
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Figure 21-2-1. Start Binary Arithmetic

2. Click [Add Image] button and select the desired image. Then click
[Open] button. The selected image will be shown additionally in the

Zoom Image Display panel.

oo TER
D (@ Mot Bepowr Sreywn Docems Theg tey

"HEQSE ¢+ 88 & BFnLxABIRESY #

Pt e | Reges | Gram | PID| Franed | 10 M

-~
s
o

il 1)

Figure 21-2-2. Select Second Image

e

3. Specify values for the X and Y weights.
4. Click the [Execute] button.
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EXEI EBx
File Edit Mode Navigator Analysis Process Effect Help

*HEQASSE € -» N

Information | Line | Region | Grain | PSD/ Fractal | 30| Multi

BB ARESG S | &

-
nm MFM 071226 Topography 002

Filo Name

MFM 071..26Topography002 | [ Show Details
Head Mode MFM
Source Topography

3 Data Width 256 (px)
100+

16

Method
11X+ 1Y
= 0
0 Add Image
©
MFM 071228MFM Amplitude002
04
-
-100
-08
o
0
12
Histogram

[ Reload | [ 0K J [ Cancel |

Image Navigator

090..pography001 | | +03.,001 cropped LCDChannet

*MF..pograph...

Figure 21-2-3. Binary Arithmetic Result
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Chapter 22 Spectroscopy Mode

Chapter 22. Spectroscopy Mode

Spectroscopy Mode is used for analysis of Force-Distance (F/D) curves,

Nano-Indentation curves, Current-Voltage (I/V) curves and Photo Current curves.

Spectroscopy Mode can be enabled by clicking the “Spectroscopy Mode” button S
in the toolbar, or by selecting the “Spectroscopy” item in the Mode menu.

22-1. Views

Spectroscopy Mode is composed of three Views.

Information View displays
information on the reference image and spectroscopy curves.

the analysis of a set of curves.
curves.

Batch View allows for
Multi View is used for the direct comparison of two
For F/D and Nano-Indentation curves, a Young’s Modulus view is added.

22-1-1. Information View

Information View displays basic metadata. It consists of an image display
panel and an information table.

The Information View can be selected by selecting
the Information tab, and is identical to the Information View for Image Mode.
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[S](=leq
File Edit Mode Navigator Analysis Help
x> AL
I Q ﬁ \j\ £ &= €« =

Infarmation | FDAnalysis | Batch | Mult

File Mame ‘ NSC19 k=06 070822 Spectroscopyd0T Hide Details

PSIATIFF Version 102
Comments |

o Reference Image on
Number ofthe Paints ‘ 16 {unity
Numer ofthe Sources 5 unin
Repeat Number ‘ 0 (unity

4] Data Number peroneace | 286 (unit
Farward Period | 106520y
Backward Period 10 sec)
Farward Speed Jon
Backward Speed 011

2 Force Constant |0e
Volume Image on

Spectroscopy point per ane fow | 4 (unip

X Map Size 23,81 (um)
3] ¥ Map Size ‘ 23.81 fum)
X Map Orset 1.8 (um)
¥ Map Offset ‘41 9 (umy
Rotation 0 (deg)
¥ Stan Size ‘ 4762 (urm)
f Scan Size 47,62 (um)
X Sean Offset | 0.gm
¥ Sean Offset 0 (pm)
Data idth | s126m0
Data Height 256 (1)
Data Gain | -2m1.30E6

Spec. Mavigator
T

NSC...troscopy...

Figure 22-1-1. Information View

22-1-2. Batch View

Batch View can be enabled by clicking the Batch tab when Spectroscopy
Mode is enabled. Batch View is designed to assist processing of multiple
spectroscopy curves, and export the processed data for further analysis. The Batch

View is consists of several components, as shown in Figure 22-1-2.
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S xEl

*HEQS<

Information| Batch | Multi

Paints.
Paint

“1

u2

@ u @ e W

10
1

@ feference O Volume

Hum)

11.905
19841
7778
35714
11.908
19821
27778
35714
11.805
19.881
27.778
35714

File Edit Mode MNavigator Analysis Process Help

€ | NN @ e

W Trace 1719 536,609 -1.430 1.694 0288 2230 0.018 Add Trace

SEX

[Force ~| vs. [Z Scan &
Maximum load (N)
@ 2,04085E-9
2
Snap-in (N)
_ 11,0485E-9
2
= Pull-off (N)
_ [ 13,2763E-9
B
I‘ . Adhesion energy {J)
' :
. L\ < ~ 1.84651E-15
2 0 2 ! [ Addpata ]
um Add Data
Cursors

Cursor aX(um) a¥(pN)  LeftX(um) Lef ¥(nN) Right %(um) Right Y(nM) Angle(deg)

W Retrace 1680 386.358 2017 1812 3696 2299 0.013 Add Retrace

11905 ~
11.905
11.905
11905
19.841
19.841
19841
19.641
27.778
27.778
27778
27778 &

Export Location : |C:#Documents and SeftingsW2i 2 THWHHE $%itest txt

Spec. Navigator
i
|
1

usc...troscopy...

Figure 22-1-2. Batch View Figure

22-1-2-1. Image Display Panel

The Image Display Panel shows a representation of the sample surface,

overlaid with a green grid to show the spectroscopy locations.

The Reference and Volume buttons will switch the display between showing

the Reference image and image derived from the Spectroscopy measurements.

207



XEI Software Manual

i .
\
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40
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0

\I-Iardness vH Enlarge ]

Figure 22-1-3. Reference and Volume

While the Volume option is selected, what it represents can be changed
using the activated down arrow button. Volume image can be exported as tiff, text and

image file by clicking on the right click on image.

Figure 22-1-4. Volume Image Export

This volume option is only shown for measurement which got from mapping.
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pm
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Figure 22-1-5. Volume Option

The Enlarge button will maximize the Image Display Panel. Figure 22-1-6

shows the display with this button enabled. When in this state, the Enlarge button is

changed to “Shrink”, which when pressed will revert the view to the previous state.
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© Reference O Volume
Points
Point X(um) Y(um)
w1 11.905 11905 ~
W2 19.841 11.905
13 27778 11.905
4 B4 11.905
15 11.905 19841
me 19.841 19.841
.7 27.778 19.841
ms 35714 19.841
9 11.905 27.778
w10 19.841 27.778
Wi 27778 27.778
W12 35714 27.778 %

Figure 22-1-6. Image Display Panel (enlarged and normal view)

22-1-2-2. Points Table

The Points Table lists the points taken in the current batch of data, along with
their X and Y positions within the image. These are also visually represented in the
Image Display Panel. You can select which of the curves to analyze by checking the
box in the Point column.

The points selected in this table will be loaded for analysis. Also, you can
export them by notepad or spread sheet by clicking on the right of mouse. You can
select and export multi points if you click other point after clicking ‘Shift’ button on the
keyboard. In this case, ‘info’ file which has position information, is also created

together with spectroscopy measurement file for each point.
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Points
Foint Hprn) lprn)
K 5.820 1.367
M: £.133 0977 |/ [T =
ma £.523 0.58 - PR ¥ 8 @
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3.0 070 ~
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1 G TENIH QJ
ma 3.438 0.31
G —
Places  Flesoftype: [Export fle (*.04) v [Cconcel

I Pointdata_Spectroscopy00] _info.txt
File Edit Format ‘Wiew Help
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Point# Position X Position ¥
Hm I m >
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7 3.0473  1.2500 Address |2 C\Documents and Settingsipatk systems|Daskkopii317
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5T
@ Copy all items ko CD

E] pointdatas_Spectroscopy001_05.kxt
E] pointdatas_Spectroscopy001_06.kxt

il e Bl Taclo &

Figure 22-1-7. Points Table

22-1-2-3. Line Display Panel

The Line Display Panel displays the selected curve. The forwards direction is

drawn in red, and the backwards direction is drawn in blue.
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Force | vs, |Z Scan A
- \
"
=T
=
=
@
Y.
. B i
300 325 350 375
nm
Cursars
Cursor axinm) ANy  LeftX(nm)y  Left ¥(nM)  Right ®(nm)  Right ¥(nM}  Angle(deg)
M Trace 25674 -7.682 3004572 -1.966 326.246 -9.649 -16.659
M Retrace 25674 -0128 351.920 -10.906 377.693 -11.034 -0.287

Figure 22-1-8. Line Display Panel

You can change the range of the display with the mouse scroll button.

Maximum load (M)
2,04035E-9

Snap-in (M)
11,0485E-9

Pull-off (M)
13,2783E-9

Adhesion energy (J)
1,B4651E-15

Add Data

Add Trace
Add Retrace

The

zoom can be changed by clicking and dragging over an area. To reset the zoom and

offset to the default field of view, double-click on the display panel.
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Figure 22-1-9. Zoom in

______________H_@_J

Maximum load (N)
2.04085E-9

Snap-in (N)
11,0485E-9

Pull-off (N)
13.2783E-9

Adhesion energy (J)
1,84651E-15

Add Data

Maximum load (N)
2,04085E-9

Snap-in (N}
11,0485E-9

Pull-off (N}
13,2783E-9

Adhesion energy (1)
1,84651E-15]

Add Data
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There are two pairs of cursors, color-coded for their lines. As these cursors

are moved, the cursor information table (Section 22-1-2-4) changes to reflect the new

locations. The cursors can be clicked and dragged, or moved with pixel precision

with the <~ and — keys on the keyboard.

40 60

nil

20

Right-clicking on the Line Display will open a context menu.

&l
Trace

Distance(nm) - Deflection{V)
Distance(nm) - Deflectioninm)
v Distance(nm) - Force(nf)
Distance(nm) - Separation{nm)
| Separation{nrm) - ForcelnM}

Retrace

Differential A

-2 et aftractive forces positive 4
BT

Figure 22-1-10. Line Display context menu

Export
You can export the trace, retrace, or both trace and retrace lines currently

shown.

Signal
The line can be changed to show different signals. This can also be

accomplished by changing the signal in the Signal Selection box.

Differential
Checking this option will change the display to show the first-order

differential of the line.

Set attractive forces positive

This option negates the Y axis for F/D curve analysis.
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There are several other useful objects in the Line Display panel.

Signal Selection boxes  [£ Detector Fit

The signal that is represented by the X and Y axes may be changed
using these boxes. The options are dependent on the signals saved during

acquisition.

Panning tool

When this is selected, the mouse cursor changes to a hand. You
can click and drag the line display to change its offset. Alternatively, you

can middle-click and drag for the same effect without this tool selected.

Zoom Out

When clicked, the display’s zoom and offset are reset so that the

whole curve is visible.

Maximum Load field
When an F/D curve is loaded in Batch view, the maximum force in
the curve is calculated and displayed in this field. For detail information,

please see XE user's manual.

Snap-in field
When an F/D curve is loaded in Batch view, the snap-in force is
calculated and displayed in this field. For detail information, please see XE

user's manual.

Pull-off field
When an F/D curve is loaded in Batch view, the pull-off force is
calculated and displayed in this field. For detail information, please see XE

user's manual.

Adhesion energy field

When an F/D curve is loaded in Batch view, the adhesion energy is
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calculated and displayed in this field. For detail information, please see XE

user's manual.

B Add Data button

This button will load the calculated values for Maximum Load, Snap-

in, and Pull-off to the Basic Information panel (Section 22-1-2-7).

22-1-2-4. Cursor Statistics Table

The Cursor Statistics Table displays information on the cursors shown in the

Line Display. The individual items in this table are defined as follows.

Cursors

Cursor Axinm) AN Left minm) Lefk inh) Right *{nm} Right *{nr) Angleideg)

M Trace 25674 -T.682 300.572 -1.966 326,246 -0.649 -16.654
B Retrace 0806 -0.140 146.787 -10.804 377583 -11.034 -0.260

Figure 22-1-11. Cursor Statistics Table

B AX
This item displays the difference in X position between the cursors, or |Left X
— Right X].

B AY
This item displays the difference in Y position between the cursors, or |Left Y
— Right Y|.

B Left and Right coordinates

The Left and Right cursors’ X and Y values are shown in these fields.
B Angle

This item shows the angle between the two cursors.

The two buttons to the right of the Cursor Information Table,

&dd Ret
and are used to add the forward and backward
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data to the Point Data Table.

Force v vs, ZScan v
Maximum load (N)
@ 2.04085E-9
g Snap-in (N)
11,0485E-9
s Pull-off (N)
3 13,2783E-9
~ Adhesion energy (J)
= v 1,84651E-15
2 0 2 ¢
pm
Cursors
Cursor aAX(um) AY(PN) LeftX(um) Left Y(nN) Right X(um) Right Y(nN) Angle(deg)
W Trace 1719 777.009 -1.430 0.745 0.288 1522 0026
M Retrace 1680 414262 2017 1679 3696 2093 0.014 Add Retrace
Point Data
Point  X(um) Y(um) Direction AX(um) AY(pN) Left X(um) Left Y(pN) Right X(um) Right Y(pN)
m 11.905 11.905 Trace 1719 536609 143 1693537 0288 2,230.145
m 11.905 11905 Retrace 168 386.358 2017 1912473 3696 2298831
ns 11905 19841 Trace 17119 777009 143 744813 0.288 1521822

Figure 22-1-12. Addding Trace Lines to Point Data

22-1-2-5. Point Data Table

The Point Data Table displays information about the points selected in the

Points Table (Section 22-1-2). The individual items in this table are defined as

follows.
Point Data
Foint i) Yl Direction Axium)  AY(p) Left ®tum)  Left ¥(pM)  Right ®{um}
M1 11.905 11.805 Trace 1.718 A36.609 -1.43 1,693,537 0.288
1 11.905 11.905 Retrace 1.68 3B86.358 207 1,912.473 3.6496
Hs 11.905 19.841 Trace 1.719 TiY.009 -1.43 Td44.813 0.288

Figure 22-1-13. Point Data table

B X and Y coordinates
These fields show the XY scanner’s position when this measurement was

taken.

Right %{ph/}
2,230.145
2,298.831
1,521.822
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B Direction
The Direction indicates whether this line was acquired in the trace direction

(Z scanner extension) or the retrace direction (Z scanner retraction).

The rest of the items in the Point Data Table are the same as those in the Cursor
Statistics Table (Section 22-1-2-4).

22-1-2-6. Export Panel

The Export Panel allows for the conversion of the data in the Point Data

Table into a text (.txt) format.

Export Location : | C:hpolymer kxk

Figure 22-1-14. Export Panel

The Export Panel has three items: the file path field, which shows the name
and location of the export file, the Change button, which allows the user to change

this name and location, and the Export button, which executes the export.

22-1-2-7. Basic Information Panel

This holds the information selected by clicking the Add Data button in the
Image Display panel. It has its own Export panel.
Basic Information Data

Paint K] Y{arm) Mazirmurm [oad(ni) Snap-in{nk) Pull aff{nik)
1 B 13.781 16.464 i} -16.204

Export Location @ [C:%Documents and SettingsW2 2 I wHIE S0 Waag, tat Change ] [ Export

Figure 22-1-15. Basic Information panel
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22-1-3. Multi View

Multi View is used for the direct comparison of two curves. It consists of an

Image Display panel, Points table, two Line Display panels, and two Cursor Statistics

tables.

File Edit Mode Navigstor Analysis Process Help
=] s Yo l=ul [ o ® . 2
PHEQASS | €« » HN | [@ $HLe
Information | Bateh| Mutti|
Hm_ [Force | vs. [Z Scan - [“Syne Cursors_| [ Syne Range
04 Point : 1
=5 T
-2 A A
° A A
2 0 2 4
um
= Cursors
Cursor AX(prn)  AY(RN)  Left X(um)  Left¥nM)  Right X(um)  Right Y(nh)  Angle(deg)
W Trace 1719 536,600 1430 1.694 0268 2230 0ms
©Reference O Volume W Retrace 1680 386,358 2m7 1912 3698 2299 oms3
Paints
Paint fum) um) Point : 1
w1 11905 1905 &
2 19.841 11.908 @
3 27.778 11.908 “©
4 35714 11.905 .2
8 11.808 18.841 =
[ 19.841 19.841 o
A \j
? 27778 19.841 o ; i
8 35714 19.841 -2 0 2 1
um
] 11.905 27778 —
10 19.841 27778 Cursors
1" 27778 27778 Cursor axium)  a¥(ph) Left X(um}  Left YinN)  Right %(um}  Right ¥InN)  Angle(deg}
08 BT 2778 W Trace 1719 636,609 1430 1.694 0268 2230 0ms
) W Retrace 1.680  386.358 2m7 1912 3696 2299 0m3
@ First O Second
. |
I
B [ E—
g
&
[usc..roscopy..]

Figure 22-1-16. Multi View

22-1-3-1. Image Display Panel

The Image Display panel shows the reference image taken together with the
spectroscopy measurements, if there was one, and the relative locations of the

measurements. It is identical to the one in Batch View (Section 22-1-2-1).
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22-1-3-2. Points Table

The points table lists all of the spectroscopy measurement points in the
currently opened file, as well as their X and Y locations in relation to the XY scanner.

Selecting a point in the table will load it to a Line Display panel.

Fuoints

Point A ()

v 1 11.905 11.905
2 19.841 11.905
3 27778 11.905
4 35.714 11.905
5 11.905 19.841
B 19.841 19.841
T 27778 19.841
S 35.714 19.841
q 11.905 2778
10 19.841 2778
11 27778 2TTT8
12 35714 ITTTE W

Figure 22-1-17. Points Table

B Point field
The spectroscopy curve’s number is displayed in this field. If
multiple measurements were saved to the same .tiff file, their order in the

Point field indicates the order in which they were taken.

B XandY fields
The X and Y fields show the XY stage’s position when the

measurements were taken.

B First and Second buttons
The selected point's curve is displayed on either the first or the
second Line Display panel (Section 22-1-3-3), depending on which of these

is selected.
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22-1-3-3. Line Display Panel

There are two Line Display panels. They are identical to the Line Display

panel for Batch View (Section 22-1-2-3).
In Multi View, there are two additional buttons in the first Line Display panel.

Farce W | w5, |Z 5can W Sync Cursors H Sync Range

Point: 1

2™y
/

-12
-
-

300 325 350 375
nm

Figure 22-1-18. Line Display panel

B Sync Cursors
When selected, the positions of the cursors in the two Line Display

panels will be matched. Moving a cursor when Sync Cursors is selected will

move its corresponding cursor in the other Line Display panel.

B Sync Range
When selected, the field of view of the two Line Display panels will

be matched, and changing one will change the other by the same amount.

22-1-3-4. Cursor Statistics Table

CUrsars

Cursor Asinmm) AN Left sinm) Left Y{ni) Right x{nm) Right ¥{nM} Angleddeg)

M Trace 2231 -6.706 304.092 -2.4977 326.403 -9.683 -16.730
B Retrace 223N -0.097 349168 -10.895 371.479 -10.992 -0.249

Figure 22-1-19. Cursor Statistics table
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There are two Cursor Statistics tables. These tables are identical to the one
in Batch View (Section 22-1-2-4).

22-1-4. Young’s Modulus View

Young’s Modulus View is enabled by clicking the Young’s Modulus tab when
Spectroscopy Mode is enabled. Young’s Modulus View is designed to support the
analysis of F/D and Nano-Indentation curves from XEP. XEI software uses the Hertz
and Oliver & Pharr methods to calculate the Young’s Modulus. Please select the
proper method according to the sample to calculate the Young’s Modulus.

*HELQASE L | €-» By & 80P 2

Information | Batch | Multi| Young's Modulus

|Force ~| vs. |Z Detector v Point: 1

‘ _I_ Model : | Hertzian Model v/

w
> 4 ©
i :
i’
- 2
EY
g > / :
£ &
p .
L\ / : — T
\
o 25 5 75 10 - o
um 18 2 22 24
um
Points Cursors
Point Xum) Yium) Cursor  aX(nm)  a¥(uN)  LeftX(um)  LeftY(uN)  Right X(um)  Right Y(uN)
4 g g2l W Force 177.440 16913 1.881 20.840 2059 3926
W Depth 177857 -6.185 2239 14174 2417 7.989

Depth :  177.660m
Tip Shape :  |Parabolic v/

Poisson's ratio of the sample : | 053]
i of tip curvature (nm): | 102

Result: 1.27GPa

Spec. Navigator

100...troscopy...

Figure 22-1-20. Young’s Modulus View

22-1-4-1. Methods

B Hertzian Method

Hertzian method views the half space for sample/tip as an isotropic, linear

elastic solid. On the words, the method assumes no other interaction other than
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elasticity and therefore no plastic deformation between sampleftip. It will calculate
Young’'s Modulus of the sample E = F (Loading force, Indentation depth). This
equation is influenced by the Indenter tip geometries. Below are equations for E using

different tip geometries.

Parabolic Conical Four-sided pyramid

VRS F= 52

4 E 3/, 2tana E E tana_,
F=-— = F= >
31— V2 ™1 — V2 1-v? 42

R, &, a and v represent the radius of tip curvature, indentation depth, face
angle with respect to vertical direction and poisson’s ratio of sample respectively.
When sample is soft, such as rubber, v will be set to 0.5. Hence, when acquiring
Force-Z displacement curve plot through F/D or Nano-Indentation, the value for E will
be calculated. When there are changes on Force-Z displacement, the cantilever will
deflect to the opposite direction as tip contacts sample. Hence, in addition to
indentation depth, F/k (k=Cantilever Spring Constant) changes must be considered.
The revised plot of the cantilever deflection in XEI will transform to display a Force-
Separation curve (F, (Z-F/k)), and this will be used for calculating the value for E. For
an accurate revision, the cantilever’s spring constant (K), and A-B sensitivity (changes

on A-B through Z Displacement) must be calibrated prior to the analysis.

B Oliver-Pharr Method
Oliver-Pharr Method follows Sneddon’s assumption that any deformation
occurring during unloading is totally due to elasticity. At this point, the relationship

between tip and sample can be calculated with the modulus of elasticity.
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Es: sample’s modulus of elasticity
Ei: Tip's modulus of elasticity
(Material for Berkovich tip is diamond, in this case, Ei=1141Gpa, Vi=0.07)

Vs: Poisson’s ratio of sample

Ee represents the converted modulus of elasticity, related to the sample’s
and tip’s modulus of elasticity. Under assumption of Sneddon, the tip is assumed as a
rigid solid, and the sample is assumed as homogeneous isotropic elastic half space.
The function below explains this contact with E. and contact stiffness. S, A and f
representing the contact stiffness, contact area and tip’s shape intercept factor.
Contact area is under the influence of the tip geometry. The tip shape intercept factor

is 1.034 for a Berkovich tip shape.

According to Sneddon’s assumption, when elastic contact is influenced by
the tip geometry, Oliver-Pharr acquires the maximum load contact area, and decides

contact depth as below function.

F
he =hp, —h, = by, — €=
€ represents the tip’s intercept factor, for a Berkovich tip, the factor is 0.75,
and for a cone shape tip, the value is 0.72 (current XEI version supports Young’s
modulus auto calibration only for the Berkovich shape tip). Contact stiffness is
acquired after fitting the unloading curve. After the contact depth (h.) is acquired, the
Young’s modulus (Es) for the sample can be acquired. At this point, the indentation
hardness (H) can be obtained as ‘H=F,/A (where the contact area is a function of

the tip shape, A=f(h.)) and contact depth (h).

NOTE!

The indentation hardness acquired is not a conventional material hardness!
To acqurie conventional hardness requires different test proccedures.
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To calculate the Young’s Modulus, XEI uses the difference in the Force (Red)
cursor pair, AX, to determine the value for hy,., The difference in the Depth (Green)
curor pair, AY, is used to determine the Maximum Load. Stiffness data is calculated
from the slope of data between Slope (Green) Cursor Pair after fitting.

Below is schematic diagram of this analysis.

lZ scannerdown(-)

>2Z
displacement

Figure 22-1-21. Calculating Young’s Modulus and Hardness(Oliver & Pharr)

22-1-4-2. Acquiring Young’s Modulus

To get the Young’s Modulus from Spectroscopy data, perform the following
steps before Cantilever’s Spring Constant (K), A-B Sensitivity (A-B changes according

to Z displacement) calibration.

B Hertzian Method
1. Place the Force (Red) Cursor Pair at Min/Max positions of the
Loading Force.
2. Choose the depth position (Loading curve’s contact point (right) and
end point (left)) by moving the Depth (Green) Cursor Pair.
3. Input parameters (Tip Shape, Poisson’s Ratio of sample, Radius of
Tip Curvature)

4. The Young’s Modulus (E) is calculated automatically.
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Force v vs, Z Detector v Point: 1
Model : | Hertzian Model v
o ©
v & |\!-
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- 17/
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Z =
o
o~ L
= \J
o e
1.8 2 22 24
pm
Cursors
Cursor AX(nm) AY(uN)  Left X(um)  Left Y(uN)  Right X(um)  Right Y(uN)
M Force 796.358 -46.478 1.748 49556 2545 3.078
M Depth 799.379 -46.551 1.748 49556 2548 3.005
Depth :  799,38nm
Tip Shape : | Parabolic v = 3
Poisson’s ratio of the sample : 052 '
R of tip curvature (nm): 102
Result :  365,8MPa

@

Figure 22-1-22. Acquiring Young’s Modulus and Hardness(Hertzian)

B Oliver and Pharr Method

Place Force (Red) Cursor Pair at Min/Max position of Loading Force.

Place Slope (Green) Cursor Pair at max position of unloading force

1.
2.

on Unloading Curve.

Input the Poisson’s ratio of the sample.
4. The Young's Modulus (E)

automatically.

and Hardness (H) are calculated
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Force v vs, |Z Detector v Point: 1

Model : | Oliver and Pharr Model v
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pm
Cursors
Cursor AX(nm) AY(uN) Left X(um)  Left Y(uN)  Right X(um)  Right Y(uN)
M Force 799.379 -46.551 1.748 49556 2548 3.005
M Slope 16.081 -6.350 1.748 49.556 1.765 43.206
Slope Cursor Index 1 : %1% [ Reset All Cursor Positions, |
Slope Cursor Index 2 : a7 bes
Contact Depth :  724.41nm
Tip Shape :  Berkovich
Poisson’s ratio of the tip : 0,07
Poisson’s ratio of the sample : 052 @

Result: 835MPa
Hardness : 3.62MPa

Figure 22-1-23. Acquiring Young’s Modulus and Hardness (Oliver and Pharr)

22-2. Processes

Spectroscopy Mode in XEl provides data processing tools specific to
spectroscopy data. These processes may be accessed by clicking on their

respective icons in the toolbar, or by selecting them from the Process menu.
.*. A=
"‘5’ =2 B3

Figure 22-2-1. Process Tool Bar
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22-2-1. Offset Adjust

The Offset Adjust process is used to improve correlation between two data
sets in Multi View. One can adjust the X and Y offsets by clicking on the + and —
buttons. Each click will increment or decrement the offset by the value in the Offset

fields. The current total offset is displayed above the control panel.

X

Offset Adjust

um Paints
Paint Klarn) W(prn)
n 1 11.905 11805 ~
2 19.841 11908
3 27778 11.905
q 4 35714 11.805
5 11.905 19841
[ 19.841 19841
3 7 27778 19.841
8 35714 19841
a 11.905 27778
g 10 19.841 2rTre
" 20778 27778
12 35714 27T~
() Fieference O Volume
Force | vs, |Z Scan )
[] Auto range
= Offset X : 0.0
offsetY: 0.0
=] Offget X
z 0% e W
=
i Offset ¥
‘ 02( »
) o8
2 0 2 : oy
um esel PRIY
Reload ] [ 0K l [ Cancel ]

Figure 22-2-2. Offset Process dialog

B Auto Range
When selected, automatically adjusts the range of the display so that

the whole curve is visible.

B Offset X and Y labels
The Offset X and Y labels show the current total offset. These

change as the + and — buttons are pressed.

B Offset X and Y fields
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The amount that the + and — buttons increment and decrement from

the offset per click is determined by these fields.
B +and - buttons
Every click of the + button increments the offset, and each click of

the — button decrements the offset.

B Reset
Reverts the Offset X and Y to O.

B Apply All
Applies the Offset X and Y to every point in the tiff file.

Clicking the Apply All and OK buttons will permanently change your data.

22-2-2. Force Constant

The Force Constant dialog is used to calculate the force constant of the

cantilever from the data.
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Force Constant ﬁ|

Force vs, Z Detector

o
£

8.375 8.4 8.425 8.45 8.475
pm

H)e]

T

g ——

-10

-15

Sensitivity (4Y/um)

Apply [ Calculate from cursars Apply

Use sensitivity of file

Force Constant {nM/nm}

Use force constant of file

Intensity Factor {Intensity,/3,0)

Apply

Use intensity factor of file

Reload ] [ 0K ] [ Cancel

Figure 22-2-3. Force Constant Process dialog

There are three values that can be changed by this process.

22-2-2-1. Force Constant

If the ‘Use force constant of file’ checkbox is selected, the force constant
used when acquiring the image is applied. Deselecting this checkbox will enable the
Force constant field, in which the user can input a new value. Clicking the Apply

button will save these changes.

22-2-2-2. Sensitivity

The ‘Use sensitivity of file’ option will apply the sensitivity value that was
saved during imaging. Selecting ‘Calculate from cursors’ will display 2 cursors on
the Line Display panel. After moving these cursors, clicking the ‘Cal’ button will
update the sensitivity. Clicking the ‘Apply’ button will use this new value for

measurement analysis.
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£ Force Constant

Force vs. Z Detector

-15 =125 -10 7.5 -5
pm

Cursors
Cursor AX(nm) aAY(V) Left X(nm) Left Y(V) Right X(nm) Right Y(V) Angle{deg)
W Trace 184764 -7.658 -15975,503 7618 -15790,739 -0.039 -90.000

Sensitivity (V/pm)
[¥) Calculate from cursors Cal |

[[) Use sensiivity of file

Force constant (nN/nm)

[ Use force constant of Sle

Intensity Factor (intensity/3,00

Apply l

[¥] Use intensity factor of file

Cancel

[ Reload || OK J [ Cancel |

Figure 22-2-4. Sensitivity Calibration

22-2-2-3. Intensity factor

(A-B) DC value is influenced by the PSPD beam intensity. Hence, the XE-
AFM calculates the force using a beam intensity normalization factor following the

function below:

Force= (A-B)DC x 3.0 (Volt) / (A+B)

1/ Intensity Factor

The beam intensity factor for normalized as (A+B) / 3.0 (Volt) since XE
software assumes that the A+B, beam intensity is 3 Volts. This value is automatically

applied to the force calculation.
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The intensity factor is properly calculated and saved in the file obtained by

the F/D and Nanolndentation Spectroscopy only after the image file is acquired.

If you want to change this value manually, please deselect ‘Use intensity

factor of file’ check box and input the desired value on the activated text field above.

Clicking the [Apply] button will use this new value for measurement analysis.

22-2-3. Filter

Filtering can be applied to remove noise from the data.

Points
Point
v1

AB  v]ve [SampleBias v

\'
45 4525 455 4575
=
2
> é
%E&f

<o

Xpm)

[ Reload J [ 0K J [ Cancel

Y{pm)

2.500

Method
Narmne:

Parameters

Kernel Size: |1 v|

2.559

Mean v

Figure 22-2-5. Filter Process Dialog

As spectroscopy data is two-dimensional, removing noise is performed by

taking the average of a data point’s neighbors, and assigning that number as the

pixel’s new value.
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45 4525 455 4575

Method Name

This parameter decides how the average is calculated. The two

options are Mean and Median.

Kernel Size

The number of neighboring data points to consider is determined by

this number. A higher value will result in a smoother curve, but may result

in loss of actual data.

Apply All

Applies the filter to every curve selected in the Points table.

45 4525 455 4575

b
B -4 1] 4 B
v
Kemel Size : 1
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E P
.ff_;
\f“—/_
8 4 [1] 4 ]
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8 4 [ 4 B
v

Kemel Size : 13

Figure 22-2-6. Filtering with Various Kernel Sizes

22-2-4. Flatten

to the Flatten process for images (Section 2-5-3).

This function is used for the reference image, if there is one.

It is identical
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22-2-5. Deglitch

This function is used for the reference image, if there is one. It is identical

to the Deglitch process for images (Section 2-5-4).
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Chapter 23. Surface Analysis

In the Surface view, you can measure and analyze surface area of an image.
You can make quantitative measurements of surface features in the selected regions
and collect surface statistics such as geometric area, surface area and surface area

ratio. These statistical values are displayed on the right of image.
In general, you can go through the following steps in Surface Analysis View:

1. Load an image you want to analyze into the Analysis view from the
Navigator view.

2. Select the Surface view.

3. Select region of the image like Region Analysis view(Entire area or
rectangle).

4. Once selecting region, the statistical values are generated with results
and updated whenever the change of the selected region occurs.

5. Filter if needed.

6. Save and print your Surface view results

Figure 23-1 shows the summarized procedure to analyze the region of an

image.
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Figure 23-1. Procedure for Region view

To enable the Surface view, select ‘Analysis>Surface’ menu or click the
Surface tab below the Toolbar. The Surface view consists of the Palette Panel,

Image Display Panel, Region Selection Toolbar, Region Histogram, Surface Statistics
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Panel and Angle Statistics Panel. Figure 23-2 shows the Surface view that is divided

into several parts.

Palette Panel Surface Statistics Panel

A

Informatioa | Line | Region | Grain | PSD| Surface §Fractal| 30 | Mut

ImagAe Display Panel Regicin Selection Tool bar

* Pentacene Surface Statistics
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Surface Area (ume): | /A
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WE‘;ELE“Q(h

100 pxifdiv

Histogram
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[
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o
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WA

Fitr : [BandPass  ~|| 02|~ 253|um

Wa\;ELEI‘\Q(h

f

400000 pxidi

Include v

o

v

Histogram

Figure 23-2. Surface view

23-1. Palette Panel, Image Display Panel and Histogram

Just as in other Analysis views, the image you want to analyze can be

displayed in the Image display panel with the Palette Panel. It is the same Palette

Panel and Image Display Panel that appears in all the analysis views of XEl. Please
refer to Chapter 3-2 and 3-3 for details.
Also the histogram of the entire image surface is displayed on the bottom of

the Image Display Panel as in the other analysis views.

23-2 Region Selection toolbar

Region selection toolbar, where the Tools for selecting region for the analysis

are gathered, is at the right side of the Image Display Panel.

B Rectangle U

Currently, you can create a specific place by using ‘Rectangle’ [l button.
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Then press the cursor at the point you want to create the top-left corner of a ‘selected
area’, and drag the mouse pointer at the point you want to create bottom-right corner

of a ‘selected area’.

B Entire Region X

To set the entire image as ‘selected area’, click the ‘Entire Region’ button.

23-3 Surface Statistics Panel

On the right of the Image Display Panel, the Surface Statistics Panel is shown.
The Surface Statistics Panel, shown in Figure 23-2, displays the surface statistics of
the all data points in the selected region. The results of the statistics on the selected
region are updated automatically when you change the selected region by resizing or
moving the region selector. Values are related to surface, hence those data that uses

metric unite of X, Y, and Z, which are topography, and Z detector data.

B Geometric Area (um?)

Area of selected region (plane)

B Surface Area (um?)

Suppose surface area as 1 by 1pixel. 1 by 1pixel is an area composed with
four different points. As shown in Figure 23-3-1, each point’ height values are named
as 71, 72, 73, and Z4. Z5 is calculated as average high value from Z1 to Z4 and
located in the middle of them. Now, there are four surface (Al, A2, A3, and A4), which

adds up for area of 1 by 1 pixel. This is how surface area is calculated.
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Figure 23-3-1. 1 by 1 pixel surface area

B Surface Area Ratio(%)

100(%) x (Geometric Area — Surface Area) / (Geometric Area)

B Filter

Histogram of surface area is displayed when selecting bandpass filter. In
Histogram, X axis indicates wavelength of surface area, and Y axis indicates
magnitude of normal vector on wavelength. Within ‘Height restriction markers’, there
are two flags (as lower and upper) displayed, using them, wavelength can be
exclude/include in selected area for filtering.

For example, click on down arrow button then select ‘Exclude’, drag these
two ‘Height restriction Markers’ on the each side of the histogram to set the lower and
upper value of the pixels to be selected. Pixels with the wavelength lower than the
‘Lower Height restriction Marker’ or higher than the ‘Upper Height restriction Marker’
will be excluded from the surface area analysis. Pixels that are excluded from the
analysis are marked in violet color at Palette bar. The ‘Height restriction marker’ is

located on top of Histogram. If ‘Filter’ option is not desired, ‘None’ can be selected.
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Figure 23-3-2. Filter

23-4 Angle Statistics Panel

On the right of the Image display panel, the Angle Statistics panel is shown.
The Angle Statistics panel, shown in Figure 23-2, displays the angle statistics of the
all data points in the selected region. The results of the statistics on the selected
region are updated automatically when you change the selected region by resizing or
moving the region selector. Values are related to surface angle, hence those data that

uses Metric unite of X, Y, and Z, which are topography, and Z detector data.

B a45(%)

Suppose surface area as four points of 1 by 1pixel. Green triangle, made of
three points’ (one datum point and two adjacent points) height, goes exceeds over
45°. It represents the ratio between number of 1 by 1pixel area and green triangle,
made of three points’ (one datum point and two adjacent points) height, where
exceeds over 45° per white plane. With this function, level of roughness in surface

area can be distinguished.
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Y

1by 1 pixel area
AN

n pixels

m pixels
m+1 data points

Figure 23-3-3. a45

B Filter

Filter for ‘a45’ value is selectable. Bandpass filter is supported. It is same

option in surface area. Therefore, for detail information, please see Section 23-3.
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Chapter 24. Stitch

Using the Stitch Processing tool, images can be stitched together.

24-1. Stitch Process Dialog

To open the Stitch process dialog, select [Process>Stitch] in the Menu or click

the =% icon in the Toolbar. The Stitch process dialog is composed of two panels, the
Image display panel and the Zoom Image Display panel, this is similar to the Crop

process dialog. Figure 11-1-1 shows the Stitch process dialog.

& stitch 3]
om Image Display Panel Cheese.tf
] X Offset (Pixel) Y Offset (Pixel)
250+ 254 -85
Add Image Loaded Cheese.td
X Offset (Pixel) Y Offset (Pixel)
) Image Add Image s T

| IP...'_

ESOA . Qq

50

Zoom Image Display Panel

L’ ’0 ’.’4

40 50

b

um

07557510"5

Crop Rectangle

Figure 24-1-1. Stitch process dialog
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B Add Image 1(2)

Opens a dialog box where you can choose the desired data files.
Images will be displayed in Image Display Panel and its’ file name will
appear on the right. The selected file can be moved by inputting offset
values for X/Y pixel. For example, in Figure 24-1-1, the initial loaded
image is 256x256 pixels and pixel offsets of Image 1 is 225, -28 and for
Image 2 is -225, 28.

B Execute

Crops the selected region (crop rectangle) and displays the image in

the Image Display panel.

B Undo

Undo the previous command.

B Redo

Redo the previous command.

B Reload

Initializes the Stitch Process Dialog.

®  Okay

Saves the Cropped image and closes the Stitch Process Dialog.

B Cancel

Stops Stitch Process and closes the window.

20-2. Stitching Images

Loads an image file into the Analysis view from the Image Navigator view. To

stitch images together, perform the following steps:

1. Open the stitching dialog by clicking [process->stitch] or by clicking

the "= icon in the Toolbar.
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3. Select the desired image and click the [Open] button. Then, the
selected image will be shown in the Image Display panel.
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4. Adjust the image position by adding X,Y pixel offsets in the text field

of added image file as desired.
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You can stitch up to 2 images together in one process step. To

stitch more than 2 images together, repeat steps 2~4. See example below.
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& Stitch

200 4

50

Move the crop rectangle over the region to be cropped.

Once you are satisfied with the new area in Zoom Image Display
panel, click the [Execute] button and the [OK] button to create a
newly cropped image that will be generated with a default name of
‘original name + stitched.tiff’ in the Image Navigator view. The
cropped image will automatically be displayed in the Image Display
panel.

Save the cropped stitched image as another file name for further

image processing and analysis.
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Appendix A. XEI Keyboard

Shortcut

For each window in XEI, a keyboard shortcut is available. Please refer to the

table below.
Shortcut Menu window Function
ESC All Process View Cancel
Right and | - Region Analysis View Selected cursor can be moved
Left arrow | >Region Histogram View
— | - -Line Analysis View>Line Profile View
Line Analysis View>Line Profile View | Selected line will move by
pixel.
Image Navigator Panel Move images to choose
Ctrl+ A -Line Analysis View, Region Analysis | Select all shapes
View, Flatten Process View>Image
View
-Multi View
Delete -Line Analysis View, Region Analysis | Delete selected shape
View, Flatten Process View>Image
View
-Multi View
Line Analysis View>Line Profile View | Delete selected cursor
Enter Image Navigator Panel Load selected image
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Customer’s Document Feedback Form

In an effort to ensure that the content of this manual is updated and accurate, Park Systems

welcomes any and all customer feedback.

If, during the course of using this manual, you come upon any errors, inaccuracies, or procedural
inconsistencies, or if you have other content suggestions, please take the time to forward your
comments to us for consideration in future manual revisions.

Please check (V) that you think this comment is critical () or moderate () or minor ().

Comments:

Customer Information

Name: Date:
Company/Institution: System
Address: model:
E-mail:
Fax:
Country: Phone:

You may fax this form or e-mail to Park Systems:

Homepage: www.parkAFM.com

E-mail (KOR) ts@parkafm.co.kr (US) techsupport@parkafm.com
Address KANC 4F lui-Dong 906-10, Suwon, Korea 443-766

Fax +82-31-546-6805

Phone +82-31-546-6800
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